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1. Bio-Plex System 
Overview 

The Bio-Plex suspension array system is a flow-based dual-laser system for 
simultaneously identifying and quantitating up to 100 different analytes in a single 
biomolecular assay. The system detects and measures molecules bound to the 
surfaces of fluorescent microspheres, providing highly accurate, real-time digital 
analysis of serum or culture media samples as small as 50 µl. The Bio-Plex system 
allows for quantitative analysis of a wide variety of cell biology assays, including 
immunoassays, complex genetic assays, and enzymatic assays. 

The Bio-Plex suspension array system is fully integrated, and consists of the 
Bio-Plex array reader and microplate platform, validation and calibration reagents, a 
selection of cytokine and phosphoprotein assays, an amine coupling kit, sample 
preparation reagents, and a computer running Bio-Plex Manager software. 

 

Figure 1. Bio-Plex array reader and microplate platform. 
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The assays contain sets of microscopic color-coded beads, each of which is 
conjugated with a different reactant. 

Reactants can include: 

• DNA 
• Enzyme substrates 
• Receptors 
• Antigens 
• Antibodies 

These can be used to create, for example, a capture sandwich immunoassay. 

To perform a multiplex reading, samples are mixed with conjugated microsphere and 
reactant mixtures and fluorescent reporter molecules are added. The assays are 
loaded into the wells of a 96-well microtiter plate and the plate is inserted into the 
Bio-Plex microplate platform. The platform and Bio-Plex array reader are controlled 
by a computer running Bio-Plex Manager software. 

The detection system in the array reader uses two lasers to analyze the microspheres 
in a flow stream. The first laser identifies each microsphere and its associated analyte 
based on the fluorescent signature of the microsphere, and the second measures the 
amount of analyte using the reporter molecules attached to the analytes. When the 
reading is complete, Bio-Plex Manager displays the raw data and generates detailed 
summary reports. 

Advantages of the Bio-Plex System 
With the Bio-Plex system, you can: 

• Simultaneously quantitate up to 100 different analytes from culture media 
and serum samples as small as 50 µl. 

• Automatically analyze all the samples in a 96-well microtiter plate—
yielding up to 9,600 data points—in about 30 minutes. 

• Instantly customize your experiments by mixing Bio-Plex assays or creating 
your own assays. 

• Analyze results, prepare reports, and print and/or export data immediately 
after each reading. 
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• Provide a complete electronic audit trail of data generation and analysis in a 
secure digital environment with multilevel account access, compliant with 
the Code of Federal Regulations, title 21, Part 11, “Electronic Records; 
Electronic Signatures.” 

For More Information… 
For more information on the principles and concepts of the Bio-Plex suspension 
array system, see Appendix 5 on page 189, or visit our Web site at 
http://www.bio-rad.com/bioplexsystem. 
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2. Bio-Plex Manager 
Software Overview 

Note on this User Guide 
All references to “Bio-Plex Manager” in this user guide refer to the Workstation 
version of the software, unless otherwise noted (see next section). 

The main body of this user guide assumes that you are using the software in standard 
mode (as opposed to Secure Mode), and does not note which features are restricted 
to which users. Secure Mode and its user levels and restrictions are described in 
detail in Chapter 9. 

This user guide assumes that you are familiar with your computer and standard 
Microsoft® Windows® commands and functions, such as opening, closing, and 
saving files, and moving and clicking your mouse. 

Software Versions 
Bio-Plex Manager software comes in three basic instrument-control versions: 
Workstation, Desktop, and Network Desktop. Each runs on a computer installed with 
the Windows® 2000 or XP operating system, and requires a hardware protection key 
(HPK, also known as a HASP) installed on either the computer itself or the computer 
network system (see page 12). 

• Bio-Plex Manager Workstation is designed to collect, analyze, and output 
data from the Bio-Plex system. It runs on a computer that is directly 
connected to the array reader and microplate platform, and can be used to 
control the platform and reader as well as analyze data. 

• Bio-Plex Manager Desktop is designed to analyze Bio-Plex data files 
using all of the analysis features available in Bio-Plex Manager 
Workstation, but does not control the Bio-Plex array reader or microplate 
platform. 
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• Bio-Plex Manager Network Desktop is a network version of Bio-Plex 
Manager Desktop that uses a single hardware protection key installed on a 
network file server to provide multiple licenses to network users. The 
network key can be configured to support 5, 10 or 20 users, depending on 
the type of license purchased. Like Bio-Plex Manager Desktop, it can only 
be used to analyze files. 

For each version listed above, there are two possible security configurations: 
Security Edition and standard version. 

o Standard version gives all users equal access to all features of the software 
with no restrictions and no electronic audit trail. 

o Security Edition provides different levels of users access to different 
features of the software and creates a complete electronic audit trail of all 
data generation and analysis. Note that Bio-Plex Manager Security Edition 
must be installed on the Windows® 2000 or XP Professional operating 
system for full security functionality. The Security Edition is described in 
detail in Chapter 9. 

Each version of the software features a standard Windows® interface, with pulldown 
menus, toolbars, and keyboard shortcuts. The computer included with the Bio-Plex 
suspension array system comes preinstalled with a compatible operating system and 
Bio-Plex Manager Workstation. 

¾ Desktop and Network Desktop versions do not include access to the instrument 
controls described in Chapter 5 or the controls for running the Protocol 
described in Chapter 7. 

¾ All references to “Bio-Plex Manager” in this user guide refer to the standard 
Workstation version of the software, unless otherwise noted. The Security 
Edition of the software is described in Chapter 9. The data analysis functions 
described herein also apply to the Desktop and Network Desktop versions of the 
software.  

General Workflow 
Using Bio-Plex Manager, you perform a reading by following these steps:  

1. Start up and calibrate the array reader. 
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2. Open or create a protocol file, specifying the analytes that you want to 
detect, the layout of the 96-well plate, and information about your 
standards. 

3. Run the selected protocol. 

4. Review the results. 

5. Print and/or export the data. 

 

 

 

 

 

 

Select analytes, standards, and plate format 

Run the Protocol 

Generate reports and review results 

Print and export the data 

Start up and calibrate array reader 

Figure 2. Workflow of Bio-Plex Manager 

The Quick Guide, which displays automatically at startup, is designed to guide you 
through the typical workflow when using the Bio-Plex system, from start up and 
calibration through shut down. Commands such as Start Up and Calibrate open 
dialog boxes that contain step-by-step instructions to guide you through the 
procedures. 

Types of Files 
There are two main types of files created and used by Bio-Plex Manager: 

• Protocol files (see page 51) contain the settings and controls for reading a 
microplate. 
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• Results files (see page 117) contain the data from each reading and tools 
and reports for analyzing that data. 

The application database file (bioplexdata.mdb) is installed on your hard drive or 
file server when you install the software. This database contains calibration, 
validation, and instrument operations information for your Bio-Plex instrument. See 
page 12 for more information. 

Key Software Features 
The key features of Bio-Plex Manager 4.0 software include: 

• Graphical user interface 
• Complete control of the Bio-Plex array reader and microplate platform 
• Automated maintenance, calibration and validation functions 
• Automatic error detection and logging system 
• Bead map and histogram 
• Raw data reports 
• Data reduction  
• Logistic curve-fitting algorithms 
• Calculation of unknown concentrations 
• Export to Microsoft® Excel, text files, and XML format 
• Microplate platform heater control 
• Complete electronic audit trail of data generation and analysis (Security 

Edition) 
• Different levels of user access (Security Edition) 
• Secure documents—Protocol files, Results files, log files (Security Edition) 
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3. Installation and 
Specifications 

System Components 
A certified Bio-Rad service engineer will install the complete Bio-Plex system at 
your site, including the array reader, platform, and computer. The setup procedure is 
described in the Bio-Plex array reader hardware manual. 

The Bio-Plex suspension array system includes the following components:  

• Bio-Plex array reader 
• Microplate platform 
• MCV Plate III (required for use with Bio-Plex Manager 4.0) 
• A Pentium®-class PC, preinstalled with operating system, Microsoft® Excel, 

Microsoft® Internet Explorer, Microsoft.net, and Bio-Plex Manager 
Workstation software 

• Software package, containing Bio-Plex Manager CD-ROM, user guide, and 
a hardware protection key 

• Instrument manual for Bio-Plex array reader and microplate platform 
• Sample tube holders (two sizes, large and small) 
• Sheath fluid bottle 
• Sample needles (one short and two long) 
• Protective shield 
• Needle adjustment tool 
• Waste bottle 
• Communications cable to connect the array reader to the computer 
• Communications cable to connect the microplate platform to the computer 
• Computer monitor 
• Power cords 

 9 
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• Computer keyboard 
• Computer mouse 

The Bio-Plex suspension array system comes with these reagents: 

• Bio-Plex calibration kit (CAL1 and CAL2) 
• Bio-Plex validation kit 4.0 (optics, fluidics, reporter, and classify 

components) 
• Bio-Plex sheath fluid 

See Appendix 7 on page 195 for a complete list of product numbers for the system. 

Bio-Plex Manager 
Bio-Plex Manager Workstation software, Windows® XP Professional, and 
Microsoft.net are preinstalled on the computer included with your Bio-Plex system. 
All versions of the software—Workstation, Desktop, and Network Desktop (see 
page 5)—can be installed from the Bio-Plex Manager CD as described in the 
following section. 
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System Requirements 
Component Minimum Recommended 
Operating 
system 

Windows® 2000 or XP Windows® 2000 or XP 
Professional 

Processor Pentium III or equivalent, 
733 MHz 

Pentium III or higher, 1 GHz or 
higher 

System BIOS Hyperthreading must be turned 
off 

Hyperthreading must be turned 
off 

Hard disk space 4 GB 40 GB 
System memory 128 MB 256 MB 
Screen 
resolution 

1024 x 768 1024 x 768 

Screen colors 256 colors 24-bit True Color 
Ports for 
connecting Bio-
Plex instrument 
(Workstation only) 

2 RS232 serial ports or 1 
RS232 serial port and 1 USB 
port with USB-to-serial 
converter 

2 RS232 serial ports 

Port for 
connecting HPK 

1 USB port 1 USB port 

Other software Internet Explorer 6.0 or higher 
Microsoft Excel 2000 or higher 

Internet Explorer 6.0 or higher 
Microsoft Excel 2000 or higher 

Installation 
To install, reinstall, or upgrade the software, insert the Bio-Plex Manager CD into 
the CD-ROM drive on your computer. 

¾ Hyperthreading must be turned off in the computer’s system BIOS to use Bio-Plex 
Manager. To turn off hyperthreading, see your computer documentation. 

¾ Before reinstalling Bio-Plex Manager, we recommend that you first uninstall any 
existing version of Bio-Plex Manager on your computer. 

¾ We also recommend that you turn off any anti-virus protection software before 
installation. Such software, if active, can greatly slow the progress of the installation. 
If you are unable to turn off your anti-virus protection software, allow 15 minutes for 
complete installation. Do not cancel the installation during this period. 

The Bio-Plex Manager Installation Program will open, displaying a navigation 
screen for performing the installation. 
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Microsoft.net 

Microsoft.net is automatically installed on your computer when you install Bio-Plex 
Manager. It is required to support the logistic curve fitting features of Bio-Plex 
Manager. 

Bioplexdata.mdb File 

During installation, you will be prompted to save the application database file 
(bioplexdata.mdb) to a location on your hard drive or a file server. This database 
file contains logs of calibration, validation, and instrument operations activity for 
your Bio-Plex instrument. 

• For more information about the Calibration Log, see page 33. 
• For more information about the Validation Log, see page 42. 
• For more information about the Instrument Operations Log, see page 48. 

You can save the bioplexdata.mdb file to any folder on your computer; the default 
location is the Bio-Plex Manager application folder. If your computer is connected to 
multiple Bio-Plex instruments, each instrument must have a separate 
bioplexdata.mdb file saved in a different folder. 

For more information about the calibration, validation, and instrument operations 
logs in Bio-Plex Manager 4.0 Security Edition, see page 155. 

¾ Note that the bioplexdata.mdb file is not compatible with versions of Bio-Plex 
Manager earlier than 4.0. If you have an earlier version of the software, installing 
version 4.0 or higher will copy the data from your existing database file 
(bioplex.mdb) into the new database. A copy of your old database will remain in the 
application folder. 

Hardware Protection Key 

A hardware protection key (HPK), or HASP key, is required to run all versions of 
Bio-Plex Manager. The version of Bio-Plex Manager you are running (Desktop, 
Workstation, or Network Desktop; Security Edition or standard version) is 
determined by the HPK. 

In the case of the Workstation or Desktop versions of the software, the HPK must be 
attached to a USB port on the computer running the software. In the case of the 
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Network Desktop version, it must be attached to a USB port on the network file 
server computer. 

The HPK has a driver that is automatically installed when you install Bio-Plex 
Manager. 

Uninstalling 
To uninstall Bio-Plex Manager from your computer, use the Windows Add/Remove 
Programs function. Click on the Windows Start button, select Settings, select 
Control Panel, double-click on Add/Remove Programs, and follow the instructions 
for removing the program. 

Technical Support 
The Bio-Rad Technical Support Department in the United States is open Monday–
Friday, 6:00 a.m. to 5:00 p.m., Pacific Standard Time. Worldwide technical support 
is available on the Web at http://www.consult.bio-rad.com/. 

Phone: (800) 424-6723, option 2, option 3 
(510) 741-6910, option 2, option 3 

Fax: (510) 741-5802 

E-mail: LSG.TechServ.US@Bio-Rad.com (U.S.) 
LSG.TechServ.Intl@Bio-Rad.com (International) 

Web: http://www.consult.bio-rad.com/
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4. Getting Started 
Before starting Bio-Plex Manager, make sure the Hardware Protection Key (see 
page 12) is attached to your computer, and switch on the Bio-Plex array reader and 
the microplate platform. This turns on the optics inside the array reader and enables 
communication between the array reader and software. 

¾ Avoid using other applications while Bio-Plex Manager Workstation is 
communicating with the array reader. Running other applications may interrupt the 
communication link between Bio-Plex Manager Workstation and the array reader. 

Starting Bio-Plex Manager 
To start Bio-Plex Manager, click on the application icon on your desktop or select 
Bio-Plex Manager 4.0 from the Programs directory on your Windows Start menu. 

 

Figure 3. Bio-Plex Manager 4.0 desktop icon. 

The software will open and connect to the Bio-Plex array reader and platform. 

Required Screen Resolution 
Your computer screen resolution must be set to at least 1024 x 768 pixels for correct 
display of the Bio-Plex Manager interface. The status bar and some dialog boxes will 
not display properly at lower resolution. If your display is currently set to a lower 
resolution: 

1. Go to the Windows Start menu, select Settings, and select Control Panel. 
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2. Open the Display control panel. 

3. In the Display Properties dialog, select the Settings tab. 

4. Drag the Screen Area slider to the right (More) until you have selected 
1024 by 768 pixels. Click on OK to accept the settings. 

   

Figure 4. Changing the screen settings. 

Communication to the Array Reader 
and Microplate Platform 

The computer running Bio-Plex Manager software is connected to the Bio-Plex array 
reader and the microplate platform by two separate serial cables. See the Hardware 
Manual for a description of the cable connections. 

COM Port Settings 
The computer COM ports assigned to the serial cables are set when Bio-Plex 
Manager software is initially installed. The default settings are COM1 for the array 
reader and COM2 for the microplate platform. 
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Communication to the array reader and platform is established when you first open 
Bio-Plex Manager. If you have a problem connecting to the array reader or platform, 
you can change the port settings from within Bio-Plex Manager itself. 

¾ To check the connection status of the array reader and/or platform, go to the status 
bar at the bottom of the main application window. The array reader status should be 
"Ready." If the status reads "Check Link," you should check your cables and COM 
port settings. 

To check or change the COM port settings, go to the Instrument menu, select Set Up, 
and select Communications. The Communication Method dialog box will open. 

 

Figure 5. Communication Method dialog. 

In the dialog, select the appropriate COM ports for the array reader and platform 
from the pulldown lists, and click on OK. Note that both connection types should be 
set to Serial. 

Disconnecting and Reconnecting 
The serial connections to the array reader and platform are closed when you exit 
Bio-Plex Manager. If you need to disconnect from the array reader and platform 
without shutting down Bio-Plex Manager software (e.g., to troubleshoot the 
instrument), go the Instrument menu and select Disconnect. 
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To attempt to reconnect to the array reader and platform while the software is open, 
select Reconnect from the Instrument menu. 

See the Bio-Plex system hardware manual for specific instructions. 

Menu and Toolbars 
Bio-Plex Manager includes a menu bar and main toolbar at the top of the application 
window. 

The pulldown menus contain all the major functions of the software. Note that these 
menus change depending on whether you are displaying a Protocol window, a 
Results window, or neither. 

The main toolbar includes the major instrument controls, including Start Up, Shut 
Down, Wash, Unclog, etc. The various Protocol and Results windows also contain 
their own toolbars, with commands specific to those windows. These are described 
in greater detail in the following chapters. 

Status Bar 
The instrument status bar shows the current state of the instrument (Calibration, 
Warm Up, Ready, Pressurizing, etc.). It includes a Cancel button for canceling the 
current operation (see page 47). 

 

Figure 6. Instrument status bar. 

When the array reader is performing an operation, the time remaining for the 
operation will be shown in the instrument status bar. 

The Bio-Plex Manager software status bar is below the instrument status bar, and 
provides information about the command under the cursor. This information is 
continuously updated as you move your cursor over the software window. 
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The software status bar also shows the current user and, if you are using the Security 
Edition of the software, whether you are in Secure Mode (shown as a “locked” 
symbol ) or standard mode (shown as “unlocked” ). See Chapter 9 for more 
information about Bio-Plex Manager Security Edition. 

The software status bar also shows the Caps Lock, Scroll Lock, and Num Lock 
keyboard status. 

Quick Guide 
When Bio-Plex Manager first opens, a Quick Guide toolbar is displayed in the upper 
right corner of the screen. The Quick Guide is designed to guide you through the 
typical workflow when using the Bio-Plex system, from start up and calibration 
through shut down. 

 

Figure 7. Bio-Plex Quick Guide. 

By default, the Quick Guide opens automatically when you start Bio-Plex Manager. 
To disable this feature, deselect the Show at Startup checkbox at the bottom of the 
guide. 

To open the Quick Guide after it has been closed, select Quick Guide from the View 
menu. 
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Sample Needle Adjustment 
See the Bio-Plex Hardware Manual for instructions on installing the sample needle. 

The height of the Bio-Plex array reader sample needle must be adjusted when (1) the 
style of microtiter plate has changed or (2) when the sample needle is replaced. The 
sample needle height is the same for flat bottom or filter plates. Note that, for round 
bottom plates, the needle must be raised so that it is slightly above the bottom of the 
round bottom well. 

¾ If you adjust the sample needle for use with round bottom plates, you will not be able 
to use the MCV Plate III without readjusting the needle to filter-plate height. 

With the Bio-Plex array reader and platform switched on, go to the Instrument menu, 
go to the Set Up submenu, and select Adjust Needle. The Adjust Needle dialog box 
will open. 

 

Figure 8. Adjust Needle dialog. 

Then follow the steps below: 

1. Click on the Eject/Retract button to eject the plate holder, and place the MCV 
Plate III on the microplate platform with the arrow pointing toward the array 
reader. 
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2. While holding the platform door open, click on the Eject/Retract button again 
to retract the plate. 

3. Tape the access door of the microplate platform open. You must be able to see 
inside the access door. 

 

Warning: DO NOT stick your hands and fingers inside the platform 
at any time. 

4. Click on the Up/Down button in the Adjust Needle dialog to lower the needle 
into the needle adjustment well in the MCV Plate III. 

5. Using the hex key needle adjustment tool (supplied with the array platform), 
loosen the screw at the top of the needle so that the needle housing can move up 
and down freely. 

6. Move the knurled dial on the needle arm and manually move it downward so 
that it just touches the bottom of the needle adjustment well. Use a flashlight to 
inspect the needle through the platform door as you adjust it. Move the needle 
up and down gently a couple of times to verify that the needle is just touching 
the bottom of the well. 

7. Tighten the needle set screw so that it is no longer possible to manually move 
the needle. 

8. Click on the Up/Down button in the dialog a couple of times to make sure that 
the needle moves freely up and down. The needle should not push down on the 
MCV Plate III. 

9. Finally, remove the tape so that the platform door can open and close normally, 
and click on the Close button to close the Adjust Needle dialog. 

See the Bio-Plex hardware manual for specific instructions. 
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5. Bio-Plex Suspension 
Array System Controls 

This chapter covers the Bio-Plex Manager commands that control basic system 
functions, such as instrument start up, warm up, calibration, validation, and shut 
down. 

¾ The Start Up, Warm Up, and Calibration functions on the Bio-Plex array system 
must be performed prior to running an assay, and all together take about 45 minutes. 

 

When performing the following operations, the sheath fluid 
container and the waste fluid container should be closely 
monitored. 

 

The sheath fluid bottle must be placed at the same level as the 
Bio-Plex array reader, unless you are using the High-Throughput 
Fluidics system (HTF; see caution below). The fluid level should 
be below the air inlet connection and above the sheath outlet 
connection. Always check the sheath fluid level before starting a 
run or procedure. 

 

If you are using the HTF, it should sit on the counter next to the 
Bio-Plex array reader, while the sheath fluid cube should be 
placed ~3–4 feet below the reader (e.g., on the floor). 

 

The waste fluid container receives waste from the system. Do not 
allow the waste container to overflow! Empty the waste bottle 
each time the sheath fluid bottle is filled. The waste container 
should be placed on the bench next to the instrument. Never place 
this container on top of the instrument. All waste containers 
should have vented caps. 
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MCV Plate III 
Bio-Plex Manager 4.0 requires the use of the MCV Plate III (MCV stands for 
maintenance, calibration and validation). This plate contains wells marked for the 
different types of fluids used in validation, washing, calibration, and other functions. 
The MCV Plate III has been modified from the previous MCV plate to work with 
Bio-Plex Validation Kit 4.0, with its enhanced Reporter and Classify bead sets. It 
also includes an open needle well for ease of needle adjustment. 

¾ The MCV Plate III is required for complete validation of the Bio-Plex system using 
Bio-Plex Manager 4.0 and Bio-Plex Validation Kit 4.0. 

 

Figure 9. MCV Plate III. 

When a particular procedure (e.g., Calibration) requires you to add solutions to the 
MCV Plate III, the dialog box describing the procedure will include a diagram of the 
MCV Plate III with the wells to be loaded highlighted in blinking yellow. 
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Wells 
highlighted in 
yellow 

Figure 10. Highlighted wells in diagram indicate wells to be filled. 

Start Up  
Start up is a series of fluidics functions that prepares the Bio-Plex array reader to 
read Bio-Plex assays. This process requires the MCV Plate III included with the 
system, distilled water, and 70 percent isopropanol. Start up takes approximately 
10 minutes. 

¾ You do not need to wait for the Bio-Plex array reader optics to warm up before 
performing the start up procedure. 

Click on the Start Up button  on the Quick Guide or main toolbar or select the 
command from the Instrument menu. Follow the step-by-step directions in the dialog 
box for preparing the MCV Plate III. 
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Figure 11. Start Up dialog. 

Insert the prepared plate into the microplate platform and click on OK to begin the 
start up process. 

Optics Warm Up and Shut Down  
To ensure accurate and reproducible results, the optics (i.e., the lasers) in the 
Bio-Plex array reader must warm up for at least 30 minutes prior to calibration and 
reading assays. Optics warm up begins when you first turn on the array reader. 

You can proceed with the array reader start up procedure described in the previous 
section while the optics are still warming up. However, if you try to perform 
calibration or an assay reading, you will receive a warning message and the reading 
will be delayed until warm up is complete. 

You can cancel the warm up procedure using the Cancel Operation command on 
the Instrument menu or the Cancel button in the status bar; however, this is not 
recommended. Results for identical readings may vary if the optics have not reached 
optimal operating temperature. 

If the array reader is idle for more than four hours, the optics will automatically 
power down (though the array reader itself will remain on). Depending on the length 
of the shut down, a full 30-minute warm up period may be required before more 
readings can be taken. 

To begin warm up after automatic power down, click on the Warm Up button   
on the main toolbar or select the command from the Instrument menu. 
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If you attempt to perform a reading after automatic power down, you will receive a 
warning message and the optics will begin warming up. 

Calibration  
Calibration of the Bio-Plex array reader is essential for optimal performance and 
day-to-day reproducibility of results. The Bio-Plex array reader should be calibrated 
each day after the start up procedure is complete and the optics have warmed up. 
Also, the array reader must be re-calibrated if the instrument temperature changes by 
more than 2º C during the course of the day. The array reader includes a temperature 
gauge; if the temperature changes by more than 2º C, a message box will prompt you 
to recalibrate.  

¾ Before calibrating, make sure that optics warm up is complete. 

The calibrators (CAL1 and CAL2 beads) are microspheres with stable fluorescent 
intensities in the RP1, CL1, and CL2 wavelength ranges. The calibration process 
uses these microspheres to adjust voltage settings for optimal and consistent 
microsphere classification and reporter readings over time and across different 
instruments. Current calibrated settings are automatically applied to any new session. 

The calibration procedure requires the Bio-Plex MCV Plate III, the bottle of CAL1 
beads, the bottle of CAL2 beads, and DI water. The CAL1 beads calibrate the array 
reader’s doublet discriminator and classification channels, while the CAL2 beads 
calibrate the array reader’s reporter channel for reporter fluorescence detection. 

Opening the Calibration Dialog Box 

To begin calibration, click on the Calibrate button  on the Quick Guide or main 
toolbar, or select Calibrate from the Instrument menu. The Calibrate dialog box will 
open. 
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Figure 12. Calibrate dialog. 

At the top of the dialog box, enter your name in the field. If you are using the 
Security Edition of the software in Secure Mode, your user name will be listed and 
grayed out. 

The time and date of the last calibration are listed, as is the temperature at the time of 
that calibration. If the temperature has not changed by more than 2º C in a single day, 
it is not necessary to recalibrate the instrument. 

Next, select the calibration type by clicking on the CAL1 & CAL2, CAL1 only, or 
CAL2 only button. You should perform both CAL1 and CAL2 calibration daily. 

Calibration Microsphere Control Numbers 
Under Select Control Numbers, you can either select existing control numbers for 
your CAL1 and CAL2 microspheres or enter new control numbers. 

Select existing control numbers from the pulldown list, and the target values for the 
control numbers will appear in the appropriate fields. 
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When you receive a new supply of CAL1 and/or CAL2 calibration microspheres, 
you must add their control numbers and target values to the Calibrate dialog. These 
numbers are printed on the bottles containing the beads. 

¾ It is critical that you enter the correct target values for your CAL1 and CAL2 
calibrators. Entering incorrect values will result in an incorrectly calibrated array 
reader, which will adversely impact assay results. 

To add a new CAL1 control number, click on the Add button under CAL1 control 
number in the Calibrate dialog. The Add New CAL1 Control Number dialog box will 
open. 

 

Figure 13. Adding a new CAL1 control number. 

In the dialog, enter the control number from the CAL1 bottle in the Enter Control 
Number field. If the expiration date is printed on the bottle, select the option button 
next to the date field under Expiration Date and click on the pulldown button next 
to the field to open the calendar selection box. 
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Figure 14. Calendar selection box 

Scroll through the calendar using the scroll buttons at the top. Select a particular date 
by clicking on it. 

Next, enter the DD, CL1, and CL2 target values for the control number, as printed on 
the bottle, in the appropriate fields. 

¾ If you are using a Luminex-type assay from another manufacturer, do not use the DD 
target value specified in the manufacturer's manual. Use only the DD target value on 
the Bio-Plex CAL1 bottle. 

When you are done, click on Add to close the dialog box and save your changes. 

To add a new CAL2 control number, click on the Add button under CAL2 control 
number in the Calibrate dialog box. The Add New CAL2 Control Number dialog box 
will open. 
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Figure 15. Adding a new CAL2 control number. 

In the dialog, enter the control number from the CAL2 bottle in the field. Select the 
expiration date, if printed on the bottle, as described above. Next, enter the High RP1 
or Low RP1 target value for the control number, as printed on the bottle, in the RP1 
field. 

¾ The CAL2 calibration bottle label lists two different RP1 target values: Low RP1 and 
High RP1. Bio-Plex phosphoprotein assays require calibration using the High RP1 
target value, while Bio-Plex cytokine assays may be calibrated with either the Low 
or High RP1 target value. Other Luminex-type assays typically require calibration 
with the Low RP1 target value. 

When you are done, click on Add to close the dialog box and save your changes. 
Your new control numbers will be added to the selection lists in the main Calibrate 
dialog. 

To delete a particular control number, first select it in the Calibrate dialog box, then 
click on the Delete button. 

Calibration Set Up 
When you have specified your control numbers of calibration microspheres and 
specified the type of calibration you want to perform (CAL1 & CAL2, CAL1 only, 
or CAL2 only), click on OK in the Calibrate dialog. 
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Another dialog box will list step-by-step instructions for preparing the MCV Plate 
III. 

 

Figure 16. Preparing the MCV Plate III for CAL1 & CAL2 calibration. 

When preparing the MCV Plate III, note the following: 
• Important: Before vortexing, remove the calibration beads from 2–8°C 

(36–46°F) storage and allow to warm to room temperature. Vortex each 
bottle for 30 seconds. Proper resuspension of the microspheres is essential 
for efficient calibration. 

• Never dilute the calibration beads, and be careful to limit their exposure to 
light. Store at 2–8° C immediately following calibration. 

• Load 5 drops of beads (approximately 200 µl) per reservoir (CAL1 or 
CAL2). 

• The DI H2O well of the MCV Plate III holds about 3 ml of distilled water. 

Performing the Calibration 
Click on the Eject/Retract Plate button to eject the microplate platform plate 
carrier, place the MCV Plate III in the carrier with the arrow facing toward the 
platform, then retract the plate. Click on OK to start the calibration process. 

As calibration proceeds, the status bar at the bottom of the Bio-Plex Manager 
window will monitor the progress of calibration. The number of beads per second 
should be 100 or higher; fewer beads per second may indicate a problem with the 
fluidics system. See the troubleshooting guide at the end of this manual. 
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Number of beads per second should be 100 or higher  

Figure 17. Status bar during calibration. 

Because calibration beads are highly concentrated, calibration is followed by three 
wash cycles using distilled water. 

An alert box will notify you whether calibration has succeeded or failed. If the 
calibration process failed, check the MCV Plate III to verify that the correct beads 
were added to the wells. Then perform a fluidics Wash (page 46) and repeat the 
above steps. For more information, consult the Troubleshooting guide on page 167. 

Calibration Log 
The Calibration Log provides a list of past calibration dates and times, results, 
instrument settings, and other data. This data is stored in a log file called 
bioplexdata.mdb, which by default is saved in the main Bio-Plex Manager 
application folder on your computer. 

¾ Note that this database is not compatible with versions of Bio-Plex Manager earlier 
than 4.0. If you have an earlier version of Bio-Plex Manager, installing version 4.0 or 
higher will copy the data from your existing database (bioplex.mdb) into the new 
database. A copy of your old database will remain in the application folder. 

To open the Calibration Log, go to the View menu and select Calibration Log. The 
Calibration Log viewer will open. 
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Figure 18. Calibration Log viewer. 

Each calibration is listed by date and time. If you are using Bio-Plex Manager 
Security Edition in Secure Mode, the User and Access Level columns list 
information about the user who was logged into the application when each 
calibration was performed. The Result column notes the result of each calibration, 
including whether it passed or failed. 

¾ If you see a drastic change in a detector’s voltage from one calibration to the next, it 
could indicate a problem with the instrument. A steadily increasing detector voltage 
may indicate that the laser is decreasing in intensity. 

On the toolbar, click on Calibration Detail to display additional information for 
each calibration, including detector gain. Click on Calibration Log  to return to 
the default view. 

For CAL1-only calibrations, the RP1 column will display a entry of NA (not 
applicable). For CAL2-only calibrations, the DD, CL1, and CL2 columns will 
display entries of NA. 

To print the calibration report, select Print from the File menu. Print Preview 
displays the report as it will appear in a printout. Print Setup allows you to select 
some standard print settings. 
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Wash Between Plates  
You should wash the fluidics lines between each plate reading to prevent traces of 
sample or other debris from building up inside the system. Click on the Wash 

Between Plates button  on the Quick Guide or main toolbar, or select the 
command from the Instrument menu. A dialog box will guide you through the steps 
for preparing the MCV Plate III for a wash procedure. 

 

Figure 19. Steps for washing between plate readings. 

Add 70% isopropanol and distilled water to the appropriate reservoirs, insert the 
plate in the microplate platform, and click on OK. This procedure performs a series 
of different fluidics operations and will take several minutes. After initial system 
pressurization (5–20 seconds), the time remaining in the operation will be displayed 
in the Bio-Plex Manager status bar. 

Remove Air Bubbles  
Microscopic air bubbles in the cuvette may cause a sudden shift in the bead regions 
during an assay reading. If the array reader detects such a shift, the reading will stop 
and you will be prompted to perform an alcohol wash to force air bubbles out of the 
system. 

Click on the Remove Bubbles button  on the main toolbar or select the 
command from the Instrument menu. A dialog box will guide you through the steps 
for preparing the MCV Plate III for the procedure. 
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Figure 20.  Steps for removing air bubbles from the fluidics system. 

Add 70% isopropanol and distilled water to the appropriate reservoirs, insert the 
plate in the microplate platform, and click on OK. This procedure performs a series 
of different fluidics operations and will take several minutes. After initial system 
pressurization (5–20 seconds), the time remaining in the operation will be displayed 
in the Bio-Plex Manager status bar. 

Unclog  
If the array reader detects an unusually low bead count during a reading, you will be 
prompted to perform an Unclog operation to remove possible obstructions from the 

fluidics lines. Click on the Unclog button  on the main toolbar or select the 
command from the Instrument menu. An instruction box will guide you through 
preparation of the MCV Plate III. 

 

Figure 21. Steps for unclogging the fluidics system. 
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Add 10% bleach solution and distilled water to the appropriate reservoirs, add 
5 drops of CAL1 beads to the CAL1 reservoir, insert the plate in the microplate 
platform, and click on OK. This procedure performs a series of fluidics operations 
and reads a sample of CAL1 beads to verify that the fluidics are operating properly. 
It will take several minutes. After initial system pressurization (5–20 seconds), the 
time remaining in the operation will be displayed in the Bio-Plex Manager status bar. 

Validation  
Validation of the Bio-Plex array reader is a formal process for documenting that the 
instrument is fit for its intended use and that it is kept in a state of maintenance and 
calibration. 

¾ Validation is performed after Start Up and Calibration have been performed. 
Validation is dependent on successful calibration for accuracy. 

You should perform a validation reading: 

• Once a month 
• Each time you move the Bio-Plex array reader, or 
• If there are problems with the array reader that cannot be solved by other 

procedures (calibrating, washing, unclogging, etc.). 

Validation Kit 
Bio-Plex Validation Kit 4.0 is used to perform validation of the Bio-Plex system. It 
must be used in conjunction with the MCV Plate III. Each Validation Kit consists of 
reagents and procedures to evaluate: 

• Optical alignment 
• Reporter channel performance 
• Efficiency of multiplexing 
• Integrity of fluidics 

The Validation Kit validates the operation of all of the primary components of the 
Bio-Plex array system, and can also be used to discriminate between assay and 
instrumentation problems. 
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Validation Kit Control Number 

Each Validation Kit has a control number linked to the specifications for the kit. You 
must use the mini-CD included in the kit to install the control number on your 
computer. After installation, you can select the control number in Bio-Plex Manager 
as described in the following section. 

See your Validation Kit manual for more information. 

Setting Up a Validation Run 

To set up a validation reading, click on the Validation button  on the main 
toolbar or select the command from the Instrument menu. The Validate dialog box 
will open. 

 

Figure 22. Validate dialog. 

Enter your user name in the top field. If you are using the Security Edition of the 
software in Secure Mode, your user name will be listed and grayed out. 
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Next, select the Control Number for your Validation Kit (see previous section) from 
the Control Number pulldown list. The expiration date for the control number will 
be listed below the field. 

If your control number is not available in the list, or the list is too long and you want 
to limit it to the control numbers you are using, click on the Add/Remove button. 

 

Figure 23. Add/Remove Control Numbers dialog. 

The Add/Remove Control Numbers dialog lists all the available validation Control 
Numbers. To make Control Numbers available in the Validate dialog pulldown list, 
you must add them to the Selected List. To select all the numbers in the Available 
List, click on the Add All>> button. To add control numbers individually, double-
click on them, or select multiple numbers using Shift + click and Ctrl + click key 
combinations and click on the Add>> button. Use the <<Remove and <<Remove 
All buttons to unselect them. At least one Control Number must remain in the 
Selected List. 

When you click on OK, the Control Numbers in the Selected List will be added to 
the pulldown list in the Validate dialog. 

To view the specifications for a Control Number, select the number from the 
pulldown list and click on the Show Specifications button. The Control Number 
Specifications dialog box will list the validation specifications. 
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Figure 24. Control Number Specifications dialog. 

Finally, in the Validate dialog select the type of validation you want to perform using 
the Validation Type option buttons: All, Optics, Fluidics, Reporter, or Classify. 

Performing a Validation Run 
When you have made your selections in the Validate dialog, click on OK. The dialog 
box for the selected type of validation will open. 

 

Figure 25. Dialog box for performing all validation types. 

See the Validation Kit manual for information about the bottles in the Validation Kit, 
and instructions on loading the MCV Plate III for validation. When you have 
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prepared the plate according to the instructions, click on Eject/Retract Plate in the 
dialog box, place the plate on the plate carrier, and click on OK. 

Validation Results 
After a run, the Validation Results dialog box will automatically open. You can also 
view this dialog by going to the View menu and selecting Validation Results. 

 

Figure 26. Validation Results dialog. 

The Validation Results dialog box includes tabs for each type of validation. If you 
selected and performed All Validations, all the tabs will be available. Otherwise, 
only the tab for the validation you performed (Optics, Fluidics, Reporter, or Classify) 
will be available and displayed. 

Click on Create Report to generate and display a Microsoft® Excel spreadsheet 
showing the validation results. Note that Microsoft® Excel 2000 or higher must be 
installed on your computer for this function to work (Excel comes preinstalled on all 
Bio-Plex workstation computers). 

See the Validation Kit 4.0 manual for interpreting the results of a validation run. 
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Validation Log 
Each validation run is recorded in the Validation Log. This log is stored in a secure 
database file called bioplexdata.mdb, which by default is saved in the main 
Bio-Plex Manager application folder on your computer. 

¾ Note that this database is not compatible with versions of Bio-Plex Manager earlier 
than 4.0. If you have an earlier version of Bio-Plex Manager, installing version 4.0 or 
higher will copy the data from your existing database (bioplex.mdb) into the new 
database. A copy of your old database will remain in the application folder. 

To view this log, go to the View menu and select Validation Log. 

 

Figure 27. Validation Log viewer. 

The validation results are listed by date and time in the upper window, and the 
specifications associated with each Control Number are listed in the lower window. 
If you are using Bio-Plex Manager Security Edition in Secure Mode, the User and 
Access Level columns list information about the user who was logged into the 
application when each validation was performed. 
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Use the buttons in the upper left corner of the window to view the different 
validation types (Optics , Fluidics , Reporter , and Classify ). 

To print the Results window, click on the Print Report Results button . To print 
the Specifications window, click on the Print Specifications button . 

To show or hide the specifications data in the Validation Log viewer, click on the 

Show/Hide Specifications Window button . 

To create a spreadsheet report for a particular validation run, click on the row for the 
run in the Results window. It will appear selected, as will the specifications 
associated with the Control Number for that run in the lower window. Then click on 
Create Report . A Microsoft® Excel spreadsheet will be automatically generated 
and displayed showing all the validation data for that run. Note that Microsoft® 
Excel 2000 or higher must be installed on your computer for this function to work. 

 

Figure 28. Validation Results spreadsheet (Microsoft® Excel). 
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Platform Heater  
The Bio-Plex suspension array system includes a microplate platform heater for 
warming samples. The heater has an operating range of 35ºC to 60ºC (95ºF to 
140ºF), and can be controlled through Bio-Plex Manager. 

To access the heater controls, select Platform Heater from the Instrument menu, or 

click on the button on the main toolbar . 

 

Figure 29. Platform Heater dialog. 

In the Platform Heater dialog, click on the Turn Heater on checkbox to turn on the 
heater, and set the target temperature within the range 35–60ºC using the scroll 
buttons. 

To automatically turn the heater off at the end of a run, select the Turn Heater off 
after run checkbox. 

The dialog box and the Bio-Plex Manager status bar will indicate the current 
platform temperature. The status bar will also indicate whether the heater is turned 
on. 

 

Figure 30. Status bar with heater on. 
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If the heater is in the process of warming up or cooling down, the temperature will be 
shown in red. If the heater is on and has reached the specified temperature, the 
temperature will be shown in green. If the heater is off and is at ambient temperature, 
the temperature will be displayed in black. 

¾ If you initiate a run before the heater has warmed up or cooled down (i.e., the 
temperature is shown in red), you will have the option of waiting until the specified 
temperature is reached or proceeding with the run immediately. 

Instrument Information  
The Bio-Plex array reader continuously monitors its internal temperature, voltage, 
pressure, and other systems for diagnostic purposes. You can access this information 

by clicking on the Information button  on the main toolbar or selecting 
Information from the Instrument menu. 

 

Figure 31. Instrument Information dialog. 

Click on the tabs in the dialog to access different information about the instrument. 
See the hardware manual for detailed instrument specifications. 
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Eject/Retract Plate  
The Eject/Retract Plate command  on the main toolbar and Instrument menu 
ejects and retracts the plate carrier in the microplate platform. Note that every 
function that requires insertion of a plate into the platform (e.g., Start Up, Wash, 
Calibrate, etc.) includes an Eject/Retract button in its dialog box.  

Additional Instrument Functions 
The Additional Functions submenu under the Instrument menu contains secondary 
instrument fluidics functions. Selecting one of these commands will open a dialog 
box to guide you through the procedure. Many of these functions require the use of 
the MCV Plate III. 

¾ Major fluidics functions such as Wash Between Plates, Remove Bubbles, Unclog, 
etc. consist of combinations of the following functions. 

Wash 

The Wash command performs a single fluidics system wash using DI water. It can 
be used to remove traces of sample in the fluidics pathway. Note that this procedure 
is less comprehensive than Wash Between Plates (page 35) 

Select Wash from the Additional Functions submenu of the Instrument menu and 
follow the steps in the dialog box. 

Drain 

This command completely drains the fluidics system of the Bio-Plex array reader—
for example, if you need to move the instrument. Make sure you have enough room 
in your waste fluid container to prevent overflow. 

Prime 

This command primes the fluidics system with sheath fluid. 
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Sanitize 

This command performs a comprehensive cleansing of the fluidics system using 
10 percent bleach and DI water. 

Alcohol Wash 

This command performs a single fluidics system wash using 70 percent isopropanol. 

Alcohol Flush 

This command performs a comprehensive cleaning of the fluidics system using 
70 percent isopropanol. 

Back flush 

This command flushes sheath fluid through the fluidics system in the opposite 
direction of sample flow, to remove particle obstructions from the cuvette. 

Cancel Operation 
The Cancel button, located in the status bar at the bottom of the Bio-Plex Manager 
window, may be used to cancel many of the instrument functions, including 
calibration, validation, or any of the fluidics functions. Click on the Cancel button to 
begin the cancellation procedure. 

¾ Certain functions may take 2–5 minutes for the cancellation process to complete. 

 

Figure 32. Cancel button in the status bar. 
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Shut Down  
The shut down procedure consists of a series of functions designed to clean the 
fluidics lines and prevent a build up of debris within the system. To initiate this 

process, select Shut Down  from the main toolbar or Instrument menu, and 
follow the instructions in the dialog box. 

 

Figure 33. Shut Down dialog. 

Instrument Operations Log 
Each operation you perform with the instrument is recorded in the Instrument 
Operations Log. This log is stored in a secure database file called bioplexdata.mdb, 
which by default is saved in the main Bio-Plex Manager application folder on your 
computer. 

¾ Note that this database is not compatible with versions of Bio-Plex Manager earlier 
than 4.0. If you have an earlier version of Bio-Plex Manager, installing version 4.0 or 
higher will copy the data from your existing database (bioplex.mdb) into the new 
database. A copy of your old database will remain in the application folder. 

To view this log, go to the View menu and select Instrument Operations Log. The 
log viewer will open. 
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Figure 34. Instrument Operations Log 

Each instrument operation is listed by date and time. If you are using Bio-Plex 
Manager Security Edition in Secure Mode, the User and Access Level columns list 
information about the user who was logged into the application when each operation 
was performed. 

To print the log, click on the Print button . 

To copy the information in the log to the Windows® clipboard and paste it into 
another document, drag your cursor over the rows and columns in the table to select 
them, and use the Ctrl + C key command to copy the data. 
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6. Preparing a Protocol 

Protocol Files  
A Protocol file contains the parameters of a Bio-Plex reading. It specifies the 
analytes used in the reading, the plate wells to be read, sample information, the 
values of standards and controls, and instrument settings. 

Protocol files also contain the controls for performing the reading. When the reading 
is complete, the settings in the Protocol file are copied into the Results file, along 
with the data from the reading. 

You can save Protocol files and reuse or modify them for other readings. Raw data 
from the most recent reading is stored in the Protocol file, and you can generate a 
new Results file from this data. 

Creating/Opening Protocol Files 
To create a new Protocol file, click on the New button  on the main toolbar or 
Quick Guide or select New from the File menu. A new Protocol window will open. 

To open an existing Protocol file, click on the Open button  on the Quick Guide 
or main toolbar or select Open from the File menu. Locate and select the file using 
the standard Windows® Open dialog. 

Standard Protocol files have the file extension *.pbx. Secure Protocol files, created 
using Bio-Plex Manager Security Edition, have the file extension *.spbx. For more 
information about Secure Protocol files, see page 155. 

¾ Secure Protocol files can only be opened as read-only files using the standard (non-
Security Edition) version of Bio-Plex Manager. 
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¾ Protocol files created or modified by Bio-Plex Manager 4.0 cannot be opened by 
earlier versions of the software. 

You can generate a new Protocol file from the settings stored in a Results file (see 
the next chapter for information about Results files). With the Results file open, 
select New Protocol from Results from the File menu. A new Protocol window will 
open.  

Saving Protocols 
To save the settings in a Protocol, click on the Save button  on the main toolbar or 
select Save from the File menu. 

After you have performed a reading (see Running the Protocol on page 89), the 
data from that reading is also saved with the Protocol file. This data is overwritten in 
the Protocol file whenever you rerun the Protocol. To preserve the data from 
multiple readings, you must save separate Results files (see page 117). 

Use Save As on the File menu to save a Protocol under a different name. You can 
create a new Protocol by opening an existing Protocol, modifying the settings, 
selecting Save As, and specifying a new name for the modified Protocol. 

Reducing the File Size of Protocols 

Protocol files that include all the data from a reading can be very large 
(>5 megabytes). Much of this file size is due to the raw bead event data from the 
reading, which is used to generate the bead map and histogram displays. If you 
require a smaller file size (e.g., you want to send the Protocol file via email), you can 
save a copy of the file without this raw bead event data, but with the other numerical 
data from the reading intact. 

¾ We strongly recommend keeping a copy of the original Protocol file with the raw 
bead event data intact. This data is necessary for changing the DD gate range in the 
Results file (see page 122), and can also be exported in XML file format from the 
Results file (see page 145) for further analysis. 
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In the Save As dialog box, select the Compressed mode checkbox to save the 
Protocol file without the bead map and histogram data. All other data will be 
preserved. 

 

Select this checkbox to 
reduce the file size of a
Protocol containing 
reading data 

 

Figure 35. Save As dialog for Protocols. 

¾ Note that this compressed file option is not available for Secure Protocol files 
generated using the Security Edition of the software (see page 155). 

Protocol Window 
The Protocol window is divided into a series of subwindows, each containing 
different controls and settings. Navigate through the different subwindows using the 
buttons along the left side of the Protocol window. 
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Click on the 
buttons to select 
different settings.

                      

Figure 36. Protocol window. 

The buttons are numbered to guide you through the selection process: 

1. Describe Protocol (optional)  (see page 55). 

2. Select Analytes  (see page 55). 

3. Format Plate  (see page 61). 

4. Enter Standards Info  (see page 73). 

5. Enter Controls Info  (see page 84). 

6. Enter Samples Info  (see page 86). 

7. Run Protocol  (see page 89). 

Click on each setting button and enter the necessary information, then select the next 
setting. After all the settings have been specified, you are ready to run the Protocol. 
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Step 1. Describe Protocol   
The Protocol description window is displayed when you first open a Protocol. 
(Otherwise, click on the Describe Protocol button to display this window.) Entering 
a description of your Protocol is optional. 

If you are using the standard version of the software, the Author field contains your 
computer login name. If you are using the Security Edition, the field contains your 
user name. Enter a new name in the field, if desired, and enter a description of the 
assay reading in the Description field. 

Step 2. Select Analytes  
In this step, you select the analytes that you want to detect in the reading. 

¾ During a reading, the Bio-Plex array reader will always detect all the analytes in the 
sample, including any that you have not selected. However, analytes that were 
detected but not selected will by default not appear in the final reports and tables. 
After a reading, you can go back and correct your selections in the Protocol window 
and/or the Results file, and the detected analytes will appear in the tables. 

Click on the Select Analytes button to view the analyte selection window. 
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Figure 37. Select Analytes window. 

Bio-Plex Manager groups analytes by panels. Preconfigured panels of analytes are 
built into the software; these panels correspond to off-the-shelf Bio-Plex assays, and 
include human, mouse, and rat cytokines and phosphoproteins. You can add to these 
existing panels of analytes, or create new panels that contain only the analytes that 
you use in your experiments. 

First you select the panel of analytes that you want to detect, and then you select the 
specific analytes. 

Selecting Analytes 
Go to the Panel pulldown menu and select from the list of preconfigured panels. The 
analytes in the selected panel will be displayed in the Available list. 

Each analyte is listed by name and region number. The region number refers to the 
region of a fluorescent color map used to identify the analyte’s bead set. Each bead 
set is embedded with specific quantities of two fluorescent dyes; the combination of 
these fluorochromes, as detected by the Bio-Plex array reader, places the bead set 
within a unique region on the color map, thereby identifying the set and its 
associated analyte. 

To move an individual analyte into the Selected list, double-click on it. Double-click 
on an analyte in the Selected list to move it back. 
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Hold down the Shift or Ctrl key and click on multiple analytes in the Available list to 
select them as a group. Then click on the Add >> button to move them over to the 
Selected list. Use the <<Remove button to return multiple selected analytes back to 
the Available list. 

Use Add All>> to move all the available analytes into the Selected list, and 
<<Remove All to move them back. 

  

 
3. Use the buttons to move your 
selections to the Selected column. 

2. Select the 
analytes in 
the Available
column. 

1. Select the panel of analytes.

Figure 38. Selecting the analytes to be detected. 

¾ Some analytes share the same region. Only one analyte per region can be added to 
the Selected list. 

Customizing Analytes and Panels 
Bio-Plex Manager comes preconfigured with a selection of panels and analytes that 
Bio-Rad provides as Bio-Plex assay kits. You can edit these and/or create new ones. 

¾ If you have assay kits for analytes that are not included in Bio-Plex Manager, you 
will need to add these analytes using the commands described in this section. 
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Creating a New Panel of Analytes 

Click on the Add Panel button  in the toolbar to create a new panel of analytes. 

 

Figure 39. Creating a new panel of analytes. 

Enter a name for the panel in the top field, then click on Add to add analytes to the 
panel. The Add Analyte dialog box will open. 

 

Figure 40. Adding a new analyte. 

Enter the bead region number of the first analyte in the Region field, and the analyte 
name in the Name field. 

¾ The bead region number must be correct for proper detection of analytes. Confirm 
that this number is correct before proceeding. 

Click on Add Continue to add the analyte to the panel and continue adding more 
analytes. When you have entered your last analyte, click on the Add button to add it 
to the list and close the Add Analyte dialog. 
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After you have added several analytes to the panel you are creating, you can use the 
Sort buttons at the bottom of the Add Panel dialog to sort them. Click on an analyte 
in the list to select it, then click on the appropriate arrow to move it up or down in 
the list. 

 
Sort buttons 

Figure 41. Sorting analytes. 

You can also remove an analyte from the list by selecting it then clicking on the 
Remove button, or remove all analytes by clicking on the Remove All button. 

To edit an analyte in the list, select it, then click on the Edit button. A dialog box 
will open in which you can change the analyte region and name. 

When you are finished creating the panel, click on OK to save your changes and 
return to the Protocol window. 

Editing a Panel of Analytes 

To edit an existing panel of analytes, first select it from the Panel name pulldown 

menu, then click on the Edit Panel button . The Edit Panel dialog box will open. 
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Figure 42. Editing a panel. 

Use the New, Edit, Remove, Remove All, and Sort buttons as described above to 
change the analytes in the panel. 

If you also change the Panel Name, the changes will be saved under the new name, 
and the old panel will not be overwritten. 

¾ The preconfigured panels (Human Cytokines, Mouse Cytokines, etc.) can be edited 
but not overwritten; therefore, you must change the panel name to preserve your 
changes. 

When you are satisfied with your changes, click on OK. 

Deleting and Renaming Custom Panels 

To delete a custom panel of analytes, first select it from the Panel name pulldown 

menu, then click on the Remove Panel button . 

To rename a custom panel of analytes, first select it from the Panel name pulldown 

menu, then click on the Rename Panel button . Enter a new name in the pop-up 
box, and click on OK. 
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Combining Panels of Analytes 
To combine entire panels of analytes (e.g., Human Cytokines I and Human Cytokines 
II) without going to the trouble of creating custom panels: 

1. Select the panels individually from the pulldown list. 

2. Use the Add All>> command to move the analytes from each panel into the 
Selected list. 

3. Save the entire Protocol as you would normally. 

Your analyte selections are saved when you save the Protocol. 

Step 3. Format Plate  
After you have selected the analytes, you are ready to specify the format of your 
96-well microtiter plate using the plate template in the Protocol window. The 
formatting in the plate template tells the Bio-Plex array reader which wells to read, 
and tells Bio-Plex Manager how to analyze the different sample types in each well. 

¾ Only formatted wells will be read by the Bio-Plex array reader. Be careful to format 
all the wells that you want to read before running a Protocol. 

Click on the Format Plate button in the Protocol window to display the plate 
template and the formatting controls. 
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Figure 43. The plate template and formatting toolbar  
(Plate Formatting view). 

The Format Plate window has two views: the Plate Formatting view and the Plate 
Groupings view. You can toggle between these views using the tabs above the plate 
diagram. As you toggle, the plate template will remain the same, but the available 
commands will toggle between formatting controls and grouping controls. 

• Plate formatting tools are used to define the types of wells in a plate 
(sample, control, standard, blank, etc.). 

• Plate groupings tools are used to organize the well types into groups, with 
one member of each group defined as the Reference (or Primary) member, 
as in a Western blot kinase assay. The ratio of each member's fluorescent 
intensity to the fluorescent intensity of the Reference can then be calculated. 

¾ Plate formatting is required to perform a reading, because only formatted wells will 
be read by the Bio-Plex array reader, whereas plate groupings are optional and can 
be defined later. 
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Plate Formatting 
To format the well types on the plate, make sure that the Plate Formatting tab is 
selected. Then use the buttons on the toolbar above the plate template to define the 
wells on the microtiter plate. These formatting commands are also located on the 
Format Options menu. 

 

Figure 44. Plate formatting tools (Plate Formatting view). 

The different well types are: 

• Unknown sample 
• Standard 
• Control 
• Blank 
• Undefined* 

*Remember that all undefined wells will not be read by the array reader. 

Defining Unknown Sample Wells 

To define wells containing unknown samples, first click on the Unknown Sample 

button , then click or drag on the wells in the template. Use the Autofill buttons 
as described on the following page for defining multiple unknown wells and/or 
replicate groups of unknowns. 

63 



Bio-Plex Manager User Guide  

 

Figure 45. Defining unknown sample wells. 

Note that the cursor changes to an Unknown Sample cursor as you move it over the 
template. As you click on each well, the wells are marked with a square and a 
number at the center. The square identifies the well as containing an unknown 
sample, and the number identifies the specific sample. 

The Set Number of Unknown Samples command (only available in the Security 
Edition of the software) is described on page 159. 

Well Numbering and Replicate Groups 

For unknowns, standards and controls, wells with different numbers contain different 
samples. Wells with the same number contain the same sample, and are defined as a 
replicate group. For each replicate group, a mean value is calculated in the Report 
table, along with the standard deviation and coefficient of variation. 

Autofilling Well Numbers 

To define multiple single wells as different samples, you can click on them 

individually, or select Autofill Across  or Autofill Down  and drag the cursor 
over the wells to number them sequentially. 
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Figure 46. Defining multiple sample wells, left to right. 

Note that Autofill Across numbers the wells sequentially left to right, then top to 
bottom, while Autofill Down numbers them sequentially top to bottom, then left to 
right. 

Defining a Replicate Group 

To define multiple wells as a replicate group, select Turn Off Autofill  from the 
formatting toolbar or Format Options menu, then drag your cursor over several wells 
that contain the same sample. The wells will be labeled with the same number. 

 

Figure 47. Defining a replicate group of unknowns. 

For each replicate group, a mean value is calculated, along with the standard 
deviation, standard error, and coefficient of variation. 
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Autofilling Replicate Groups 

If you have multiple replicate groups of wells in rows or columns, you can autofill 
these by selecting Autofill Across or Autofill Down as before, and then entering the 
number of wells in the replicate group (up to 96) in the number field next to the 
autofill buttons. (You can also select a well number up to 10 from the pulldown 
menu.) 

 

Figure 48. Entering the number of replicate wells in an autofill sequence. 

Now when you drag your cursor, the sequential sets of replicate wells will be 
defined. 

 

Figure 49. Autofilling a sequence of replicate groups. 

For each replicate group, a mean value is calculated, along with the standard 
deviation, standard error, and coefficient of variation. 
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Changing a Replicate Group 

To change the replicate group of a well or group of wells: 

1. Click on the Select tool , and click or drag on the wells that you want to 
change. The wells will appear highlighted. 

2. Right-click on the selection, and select Set Replicate Group from the 
context menu. 

3. In the pop-up box, select the desired replicate group number from the 
pulldown list. 

4. Click on OK. The selection will be changed to the specified group number. 

               

Figure 50. Selecting a different replicate group 

Resequencing Well Numbers 

If your well numbering is out of sequence and you want to correct it, select 
Resequence Well Names from the Format Options menu. All the wells in the plate 
will be renumbered sequentially, based on whether you have select Autofill Across 
or Autofill Down. This is a cosmetic change, and will not affect the analysis in any 
way. 

Defining Standard Wells 

Standard wells contain analytes of known concentration, which are used to generate 
a standard curve of fluorescent intensity versus analyte concentration. The regression 
equation for the curve is then used to calculate the concentrations of your unknowns. 

To define the wells containing standards in your microtiter plate, click on the 

Standard button , then click or drag on the wells in the template. Use the 
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Autofill buttons as described on page 64 for defining multiple standard wells and/or 
replicate groups of standards. 

 

Figure 51. Defining a row of standard wells. 

Note that the cursor changes to a Standard cursor as you move it over the template. 
Standard wells are marked in the template by a circle with a number inside it. 

¾ After you have defined the standard wells, you are ready to enter the concentrations 
of the standards as described on page 73. 

Defining Control Wells 

Control wells contain samples of known concentration; the expected versus observed 
concentrations of the controls can be calculated at the end of the reading. 

To define the wells containing controls in your microtiter plate, click on the Control 

button , then click or drag on the wells in the template. Use the Autofill buttons 
as described on page 64 for defining multiple control wells and/or replicate sets of 
controls. 
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Figure 52. Defining a row of control wells. 

Note that the cursor changes to a Control cursor as you move it over the template. 
Control wells are marked in the template by an octagon with a number inside it. 

¾ After you have defined the control wells, you are ready to enter the concentrations of 
the controls as described on page 84. 

Defining Blank Wells 

In certain types of assays such as the Bio-Plex phosphoprotein assay, it may be 
useful to subtract the assay background from the readings of standards, controls, and 
unknown samples. To do this, you can prepare "blank" wells containing all the assay 
components except sample. Wells prepared as blanks are read along with the rest of 
the assay, and then Bio-Plex Manager subtracts the mean background reading of 
these wells from the fluorescent intensity values of the wells containing standards, 
controls, and unknowns. 

To format blank wells in the plate template, click on the Blank button , then click 
or drag on the blank well(s) in the template. Note that the cursor changes to a Blank 
cursor as you move it over the template. 
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Figure 53. Defining a row of blank wells. 

Blank wells are marked in the template with a diamond shape containing a letter B. 

Multiple blank wells in a template are treated as a single replicate group. A mean 
value, standard deviation, standard error, and coefficient of variation are calculated 
for the group, and the mean is used as the background value. 

Deleting or Changing Well Formatting 

To delete the formatting from a well or set of wells, select Undefined  from the 
toolbar or Format Options menu, then click or drag on the well(s). To clear the 
formatting from all the wells in the template, select Clear Plate from the Format 
Options menu. 

To change the formatting of a well or group of wells, simply select the appropriate 
tool and overwrite the old formatting, as if you were defining the wells for the first 
time. 

Plate Groupings 
After you have formatted the wells (see previous section), you can organize them 
into groups and identify one member of each group as the Reference, or Primary 
member. You can then calculate the ratio of each member's fluorescent intensity to 
the fluorescent intensity of its Reference. This type of analysis is similar to that 
performed in Western blotting. 
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Click on the Plate Groupings tab to display the plate groupings tools. 

 

Figure 54. Plate Groupings view. 

The buttons on the toolbar are used to group the wells on the microtiter plate diagram 
and identify the Reference well(s). These formatting commands are also located on 
the Format Options menu. 

 

      

Figure 55. Plate groupings tools (Plate Groupings view). 

First, select the ratio you want to calculate for each group—Reference/Member or 
Member/Reference—using the Ratio field pulldown list. 
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Defining a Group 

To define an assay group, click on the Group button  and drag the cursor across 
the defined wells in the assay. Note that: 

• Wells must be defined as Samples, Standards, Controls, or Blanks before 
they can be grouped. 

• You can group across well types (e.g., a single group can include Standards, 
Samples, Controls, and/or Blanks).  

• Replicate wells will be automatically placed in the same group (even if you 
drag over only one well in the replicate set). 

 

Figure 56. Defining a group of wells. 

The grouped wells will change color to indicate their grouping, and the first member 
of the group will be highlighted to indicate that it is defined as the Reference well. 

Each group you create will be designated with a different color. 

To remove individual members of a group or the entire group, click on the Ungroup 

Samples button  and click or drag over the members/group. 

Note that you can also use the Select tool  to first select a group of wells, and then 
use the Set Sample Group command on the Format Options menu or context menu 
to select the group. 

Defining the Reference 

To change the Reference member of the group, click on the Reference button  
and click on the desired Reference member in the group. For replicates, all replicate 
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wells of the same number within the group will be automatically designated as the 
same Reference. 

You can also use the Select tool  to first select the Reference well within a group, 
and then use the Set Sample as Reference Member command on the context menu 
to set the Reference. 

Printing the Plate Format 
To print the plate format for your records, select Print from the File menu, or click 
on the Print button  on the main toolbar. For a preview of the printed format, 
select Print Preview from the File menu. 

Step 4. Enter Standards Info  
Standards are analytes of known concentration, which can be used to generate a 
standard curve of values using one of the several regression methods built into 
Bio-Plex Manager. This curve can be used to calculate the concentrations of your 
unknowns. 

The standards you select will depend on the performance characteristics of your 
assay as well as the type of curve-fitting model you want to use. Due to variations in 
assay preparation, we recommend using a minimum of eight standard concentrations 
to generate the standard curve. See the Bio-Plex cytokine assay manual for 
recommendations of specific standard concentrations. 

The minimum number of non-zero standards required for each type of regression 
method available in the software is shown in the following table: 

Method Minimum number of standards 

Logistic-5PL 6 

Logistic-4PL 5 
Cubic spine 4 

Linear (linear and semi-log) 2 

Point to point (linear and semi-log) 2 

Before entering the concentration values of your standards, you must select the 
analytes that you will be analyzing in the reading as described on page 55. If your 
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current plate contains your standards, you must also identify the standard wells as 
described on page 67. 

Click on the Enter Standards Info button in the Protocol window to enter 
information about your standards. 

 

Figure 57. Entering information about standards. 

The Enter Standards Info window allows you to define standards on your current 
microtiter plate, and/or import external standards data from another plate. Use the 
tabs above the data fields to select between standards on the current plate and 
external standards. 

¾ You can define standards on the current plate and import external standards in the 
same Protocol. This is useful if you want to run standards for some analytes on the 
current plate, but include external standards for other analytes in your concentration 
calculations. Note that, if external standards and current standards are defined for the 
same analyte, the external standards will always be used to calculate the 
concentrations of that analyte. 
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Selecting External Standards 
This section describes how to select a Results file from which to import external 
standards data. If you are not using external standards, you can skip this section and 
proceed to Entering Standards Information on page 76. 

Click on the Select External Standards tab. In the window, click on the Fill 
Available List button, navigate to the directory containing the Results file with your 
standards of interest, and select the file. (Note that the Open dialog will only display 
Results files.) 

 

    

 

Figure 58. Selecting the Results file containing your external standards. 

The Available External Standards list will be populated with the standards from the 
selected file. To add additional standards to the list, repeat the procedure, selecting a 
different file. 

To delete all standards from the Available list, click on the Clear Available List 
button. 

75 



Bio-Plex Manager User Guide  

To make the available external standards accessible in the current Protocol, you must 
add them to the Selected External Standards list (right-hand pane). To select all the 
standards in the Available column, click on the Add All>> button. To add available 
standards individually, double-click on them, or select multiple analytes using 
Shift + click and Ctrl + click key combinations and click on the Add>> button. (Use 
the <<Remove and <<Remove All buttons to unselect them.)  

¾ Each external standard you select must match the region of a selected analyte in the 
Protocol. For example, if you selected analytes in regions 19, 32, and 34 in the Select 
Analytes window (page 55), you can only select external standards in those same 
regions. (Note that the analyte name does not have to match—only the region.) Also, 
each analyte must come from a different region. 

When you are finished, the Selected list should list all the analytes that you want to 
use as external standards, and their source file(s). 

 

Figure 59. Selected external standards. 

When you are done, click on the External Standards Info tab to enter additional 
information about your external standards. 

Entering Standards Information 
This section describes how to enter information about your standards. To enter 
information for standard wells defined on the current plate, make sure that the 
Standards Info tab is selected. To enter information for external standards, first select 
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the external standards as described in the previous section, and then click on the 
External Standards Info tab. 

¾ The fields under these tabs are the same, except that you cannot alter the 
concentrations under the External Standards Info tab (they will appear grayed out), 
as shown in Figure 60. 

 

 

Figure 60. Standards Info window (top) and External Standards Info window 
(bottom) (external standards concentrations cannot be changed). 
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The analytes that you selected in the Select Analytes window will be available under 
the Analyte pulldown list. Select the first analyte that you will be using as a 
standard. 

 

Figure 61. Selecting a standard analyte. 

¾ For the settings described on the following pages, you can select different settings 
for each analyte, or select the same settings for all analytes. 

Entering Concentrations (for Current Standards Only)  

After you have selected an analyte, you are ready to enter the concentrations of the 
standards on your current plate. If you are using external standards, the 
concentrations will be automatically entered, and you can skip to the next section on 
selecting concentration units (page 80). To enter concentrations, make sure the 
Standards Info tab is selected. 

To enter the concentrations manually, select Enter Manually. To calculate them 
automatically from a dilution series, select Enter Automatically. 

Entering Concentrations Manually 

If you selected the Enter Manually option button, the table will list your standard 
wells (S1, S2, S3, etc.). These are the wells that you defined in the Format Plate 
window (page 61). For the selected analyte, enter the concentration for each standard 
in the concentration column. 
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Selected analyte 

Entered 
concentrations 

 

Figure 62. Entering standard concentrations manually. 

If the Same conc. values for all analytes checkbox is selected, the concentration 
values you enter will be applied to all the analyte standards. Deselect the checkbox if 
you want to enter different concentrations for each analyte standard. 

You can also enter additional information about your standards in the description 
column for each well. 

¾ You can use the Cut, Copy and Paste commands on the Edit menu to copy your 
descriptions and concentrations between analytes. You can also copy and paste from 
and to other applications, such as Microsoft® Word or Excel. Click on a cell, row, or 
column in the table to copy and paste. 

If you are entering different concentrations for each analyte standard, repeat the 
procedure by selecting each analyte from the pulldown menu as described above. 

Calculating Concentrations Automatically 

If a dilution series was created for the standards, the software can automatically 
calculate the concentrations of each standard. Select the analyte, and then select the 
Enter Automatically option button. 

First, select the appropriate Most Concentrated Standard well number. (The most 
concentrated standard must be in either the first standard well or the last.) 
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Figure 63. Entering standard concentrations automatically. 

Then enter the concentration of the most concentrated standard in the Concentration 
of S1 field and the dilution factor for the remaining standards in the Dilution Factor 
field. 

¾ Calculations are made by dividing by the dilution factor, so do not enter fractional 
values for the dilution factor. If each standard is half the concentration of the 
previous standard, enter 2 for the dilution factor. If each standard concentration is 
one-fourth the previous, enter 4, and so on. 

Click on the Calculate button when all the information is entered. The 
concentrations in the table will be automatically updated. 

If the Same conc. values for all analytes checkbox below the concentrations table is 
selected, the concentration values will be applied to all the analyte standards. 
Deselect the checkbox if you want to enter different concentrations for each analyte 
standard, and repeat the procedure. 

Concentration Units 

You can enter the units of concentration in the Concentration Units field (note that 
units are not required and will not affect calculations). These units will appear in 
your reports. If all your analytes have the same concentration units, select the Same 
units for all analytes checkbox. 
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Regression Method 

Using the Std Regression Curve pulldown list, choose from among seven different 
regression methods to generate the standard curve (page 138): 

• Logistic-5 PL 
• Logistic-4 PL 
• Linear 
• Cubic spline 
• Point-to-point 
• Linear (Semi-log) 
• Point-to-point (Semi-log) 

 

Figure 64. Selecting a regression method. 

You can change your selection later in the Standard Curve window of the Results 
file. See page 138 for a more detailed discussion of the different regression methods. 

You can also select the regression curve axis scale from four different combinations 
of linear and logarithmic. Select the axis scale from the Axis Transformation 
pulldown list. 

 

Figure 65. Selecting a regression curve axis transformation. 

Note that the axis transformation only changes how the curve is displayed, not the 
calculated values. 
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¾ The regression method and axis transformation you select in the Protocol window 
will be used to calculate your initial results. However, these settings will not affect 
the reading, and you can change these settings and recalculate your results after a 
reading is complete. 

Finally, if you want to use different regression methods for different analytes, 
deselect the Same regression type for all analytes checkbox. Then, when you select 
a different analyte from the pulldown list, you can select a new regression method as 
well. 

Logistic Weighting 

If you select a logistic curve fitting method (Logistic 5PL or Logistic 4PL), the 
software will perform automatic weighting of the points in the curve. Click on the 
Logistic Weighting button to access the weighting algorithm controls. 

 

Figure 66. Logistic Weighting dialog. 

There are eight models for calculating the variance in the logistic weighting 
algorithm: 

• Linear Variance 
• Logarithmic Variance 
• Exponential Variance 
• Power Law Variance (default) 
• Linear CV 
• Logarithmic CV 
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• Exponential CV 
• Power Law CV 

Coefficient a 

Weighting coefficient a will be automatically calculated using the following 
equation: 

a = .002 * pow ((m_YMax + m_YMin) / 2 + blank,.2) 

Alternatively, you can enter your own value by deselecting the Auto calculate 
coefficient a checkbox and entering a value in the Coefficient a field. 

Coefficient b 

Weighting coefficient b has a default value of 1.8. You can enter a different value in 
the Coefficient b field. 

Recovery Percentage Range 

Because the standard curve (page 138) is critical for calculating the concentrations of 
your unknowns, Bio-Plex Manager includes a mechanism for assessing the fit of the 
curve to the standards. This is the recovery percentage. 

For each analyte standard, an observed concentration is back-calculated from the 
standard curve and the fluorescent intensity. This is divided by the expected 
concentration as entered in the Enter Standards Info window and multiplied by 100 
to give the recovery percentage: 

Recovery percentage = Observed conc/Expected conc * 100 

Recovery percentages are also used with controls (page 84) to determine the overall 
accuracy of an assay. 

In the Enter Standards Info window, use the Acceptable Recovery Percentage 
Range pulldown menu to select an acceptable recovery range. 
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Figure 67. Selecting the recovery percentage range. 

For example, if you select a range of 70–130%, the observed concentration should be 
within 70–130% of the expected concentration. 

The actual recovery rate for each standard and control is shown in the Obs/Exp*100 
column of the Report table (see page 132). Concentrations that fall outside this range 
are flagged as *** in the Conc in Range column of the Report table. 

Step 5. Enter Controls Info  
Controls are samples of known concentration whose values are measured during a 
reading in the same manner as the unknown samples. You can then compare the 
calculated concentrations of the controls after a reading with the expected 
concentrations to determine the overall accuracy of the assay. (This is sometimes 
called the “spiked” recovery method, because you are “spiking” your assay with 
known quantities of analytes.) 

In this step, you enter the concentration values of your controls. First, you must 
select the analytes that you will be analyzing in the reading as described on page 55, 
and identify the plate well(s) containing your controls as described on page 68. 

¾ Only formatted wells will be read by the Bio-Plex array reader. Be sure to define all 
your control wells before running a Protocol. 

Click on the Enter Controls Info button in the Protocol window to enter 
information about your controls. 

84 



 Chapter 6.  Preparing a Protocol 

 

Figure 68. Enter Controls Info dialog. 

The analytes that you selected in the Select Analytes window will be available under 
the Analyte pulldown menu. Select the first analyte that you will be using as a 
control. 

The table will list your control wells (C1, C2, C3, etc.). These are the wells that you 
defined in the Format Plate window (page 61). Enter the concentration of the 
selected analyte in the Conc column for each well. 

 

Selected analyte 

Entered 
concentrations 

Figure 69. Entering concentrations of the controls. 
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If the Same conc. values for all analytes checkbox is selected, the concentration 
values you enter will be applied to all the available control analytes. Deselect the 
checkbox if you want to enter different concentrations for each control analyte. 

You can enter additional information about your controls in the description column 
for each well. 

If you are performing a dilution of your controls, you can enter a dilution factor for 
each control in the Dilution column. Note that a control diluted 1 in 2 would have a 
dilution factor of 2. This feature allows for the performance parallelism studies, 
whereby a control diluted by different dilution factors is analyzed to verify that the 
final concentration is the same for all of the samples. 

 

Figure 70. Controls with different dilution factors. 

If you are entering different concentrations for each analyte standard, repeat the 
procedure by selecting each analyte from the pulldown menu as described above. 

To enter the same dilution factor for all controls, enter the value in the Dilution 
Factor field, and click on the Set All Dilution Factors button. The dilution factor 
you enter for one analyte is automatically applied to all analytes. 

¾ You can use the Cut, Copy and Paste commands on the Edit menu to copy your 
descriptions, concentrations, and/or dilutions between analytes. You can also copy 
and paste from and to other applications, such as Microsoft® Word or Excel. Click 
on a cell, row, or column in the table to copy and paste. 
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Step 6. Enter Sample Info (optional)  
Before entering information about your unknown samples, select the analytes that 
you will be analyzing in the reading as described on page 55, and then identify the 
plate well(s) containing your unknown(s) as described on page 63. 

¾ Only formatted wells will be read by the Bio-Plex array reader. Be sure to define all 
your unknown sample wells before running a Protocol. 

Click on the Enter Sample Info button in the Protocol window to enter information 
about your unknown samples. 

 

Figure 71. Enter Sample Info dialog. 

The information table will list all the unknown sample wells as defined in the plate 
template for the reading (page 63). 

You can enter a description and a dilution factor for each unknown in the appropriate 
columns. Note that a sample diluted 1 in 2 would have a dilution factor of 2. To enter 
the same dilution factor for all unknowns, enter the factor in the Dilution Factor 
field and click on the Set All Dilution Factors button. 
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¾ You can use the Cut, Copy and Paste commands on the Edit menu to copy your 
descriptions and/or dilutions from and to other applications, such as Microsoft® 
Word or Excel. Click on a cell, row, or column in the table to copy and paste. 
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7. Running the Protocol  
After you have prepared the Protocol as described in the previous chapter, you are 

ready to run the Protocol. Click on the Run Protocol button  in the Protocol 
window to select the final settings and run the Protocol. 

 

When performing the following operations, the sheath fluid 
container and the waste fluid container should be closely 
monitored. 

 

The sheath fluid bottle must be placed at the same level as the 
Bio-Plex array reader, unless you are using the HTF (see caution 
below). The fluid level should be below the air inlet connection and 
above the sheath outlet connection. Always check the sheath fluid 
level before starting a run or procedure. 

 

If you are using the HTF, it should sit on the counter next to the 
Bio-Plex array reader, while the sheath fluid cube should be placed 
~3–4 feet below the reader (e.g., on the floor). 

 

The waste fluid container receives waste from the system. Do not 
allow the waste container to overflow! Empty the waste bottle 
each time the sheath fluid bottle is filled. Do not place it on the 
instrument. All waste containers should have vented caps. 

Run Protocol Window 
The Run Protocol window has controls for performing the run, and two views for 
displaying the status of the run: the Raw Data table view and the histogram/bead 

map view. Click on the Show/Hide Histogram/Bead Map button  to display 
only the Raw Data table, or the histogram/bead map display with the Raw Data table 
below it (maximize the window to see both the table and the display). 
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Figure 72. Run Protocol window—Raw Data table view. 

 

Figure 73. Run Protocol window—Histogram/bead map view. 
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The bead map and histogram (see page 99) provide graphical data about a run, and 
are continually updated throughout the run. The Raw Data table (see page 109) 
displays the raw data of the reading after it is complete. 

The controls for performing the run are described in the following sections.  

Bead Count 
The Beads field lists the number of beads to be detected before a reading is 
complete. Note that this number can be beads per region or total detected, 
depending on the pull-down menu selection. 

If you select per region as the counting method, you can enter a number between 1 
and 10,000 in the Beads field. For most assays, including the Bio-Plex cytokine 
assay, we recommend a value of 100 beads per region. This ensures that at least 100 
beads in each region will be acquired before sample acquisition is complete. 

For the Bio-Plex phosphoprotein assay, we recommend specifying 25 beads per 
region to avoid triggering a low bead count warning. 

¾ Under Select Analytes, be careful to select only those bead types that are present in 
your samples. If you select a bead type that is not present, the array reader will be 
unable to count the target number of beads of that type, triggering a warning. 

If you select total as the counting method, you can enter a number between 1 and 
100,000 in the Beads field. Note that if you choose to measure total beads, the 
instrument will stop acquisition as soon as it has acquired the total number of beads 
in any combination of bead sets. If you are detecting multiple analytes, this means 
that some bead sets may be underrepresented in the final tally. 

Advanced Settings 
Click on the Advanced Settings button to access additional reader settings and 
controls. 
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Figure 74. Advanced Run Settings dialog. 

Sample Size 
The Sample Size is the amount of sample that will be aspirated from the microplate 
well by the reader. The default sample size of 50 µl is recommended. You can 
specify a sample size as small as 10 µl or as large as 200 µl. 

¾ To avoid air uptake, make sure that the sample needle is properly aligned (see 
page 20) and each well to be read contains at least 125 µl of sample. The maximum 
sample volume per well is approximately 140 µl. (The array reader rinses an 
additional 160 µl into each well after a reading is complete; the maximum well 
capacity is 300 µl.) 

Automatically Saving Results 
You can automatically save the Results file generated by the reading. With the Auto 
Save After Run checkbox selected, when you click on Start to begin a reading, you 
will be prompted to enter a name for the Results file. 

¾ In Bio-Plex Manager Security Edition, Secure Mode, this checkbox is selected and 
cannot be deselected (see page 161). 

If the Auto Save After Run checkbox is selected, you can also select the Auto 
XML Export After Run checkbox. With this checkbox selected, Bio-Plex Manager 
will automatically generate an XML file and save it to a folder or open it in an 
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application after the reading (these options are specified in the XML Export 
Properties dialog). The XML file will have the same name as the Results file. For 
more information on XML files, see page 145. 

Sampling Errors 
During a reading, the Bio-Plex array system is continuously monitoring the flow of 
beads, the bead count, the bead regions, and the platform temperature. If the system 
detects a problem in any of these areas, it can stop the reading and trigger a warning. 
This feature is enabled if any or all of the checkboxes under Sampling Errors are 
selected. 

Select Pause Run If Error Occurs to select all the possible error conditions, or 
select/deselect the individual error condition checkboxes. By default, these are not 
selected (i.e., the run will not pause for any error condition). 

 

Figure 75. Error condition checkboxes 

¾ All errors will be logged in the Raw Data and Report tables, whether or not the 
checkboxes are selected (see page 111). 
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The reading errors and their possible causes are listed in the following table: 

Error Possible Cause* 

1. Low bead number Too few beads in the assay; buffer volume in well is 
too low; plate was not shaken properly before 
analysis; microbubbles in the cuvette. 

2. Aggregated beads Bead clumping in the assay; sheath fluid is empty; 
waste reservoir is overfull. 

3. Classify efficiency Microbubbles in the cuvette; beads have become 
photobleached; percentage of beads outside the DD 
gate range is too high. 

4. Region selection Incorrect beads were selected in the Protocol or 
assay; too few beads are present in the assay. 

5. Platform temperature Platform temperature has fluctuated +/- 2ºC during 
the reading. 

* See Appendix 1 on troubleshooting on page 167 for a detailed list of reading 
errors, causes, and suggested solutions. 

With the checkboxes selected, the reading will stop and an alert box will describe the 
problem and suggest steps for correcting it. After you have performed the suggested 
steps, you can rerun the reading. 

¾ If you are rerunning wells in rerun recovery mode, you may want to disable the Low 
bead number checkbox since there is a lower bead number in a well that has already 
been read once. 

PMT Voltage 
Users who want to manually set the PMT voltage on the reporter detector can select 
the Override calibration checkbox in the Advanced Run Settings dialog and enter a 
new voltage in the PMT Volts field. 
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¾ Note that the PMT voltage is set during calibration, and should only be adjusted by 
users who know the precise PMT value that they want to specify. If you change the 
PMT, you will no longer have day-to-day and unit-to-unit reproducibility of results. 
The PMT voltage will be reset to the calibrated values after the plate is read and the 
results generated. 

Doublet Discriminator Gate Range 
During a reading, a doublet discriminator (DD) channel measures the amount of light 
scatter from particles that flow past the red laser. The light scatter is directly 
proportional to particle size, and an internal DD “gate” is designed to identify 
particles that are smaller or larger than a single microsphere, including microspheres 
that are clumped or aggregated. 

In the Advanced Run Settings dialog, the default DD Gates range (Low = 4335; 
High = 10000) is designed to accommodate the standard 5.5-µm beads distributed by 
Bio-Rad. If you are using different-sized beads, you can change the size of the gate 
by selecting the Override gates checkbox and entering new values in the Low and 
High fields. 

You can also change the range by dragging the red lines on the Run Protocol 
window histogram (see page 102). 

¾ The values in the fields are channel numbers corresponding to the amount of light 
scatter from a particle. Beads of 5.5 µm fall squarely within the default range. If you 
want to change the range, you will need to know the approximate channel numbers 
corresponding to the size of the beads you are using. 

¾ You can change the DD gate range in the Protocol before a reading or in the Results 
file after a reading (see page 122). If you change the DD gate range in the Results 
file, a record of the range during the reading will be preserved. 

¾ You can only set the gates on the DD channel, not the RP1, CL1, or CL2 channel. 

¾ For Bio-Plex assays or Luminex-type assays from other manufacturers, the default 
DD gate settings should work well. However, if you are developing your own assay, 
the position of the DD peak may shift and thus the DD gates may need to be shifted 
accordingly. Note that you can adjust the DD gate range after a reading in the 
Results file and re-analyze the data. 
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Plate Loading Guidelines 
Before starting the run, note the following plate handling guidelines and warnings: 

 

Protect your assay microspheres from light. Once photobleached, 
the beads are no longer usable. Proper care of microspheres must be 
observed to maintain the benefits of your product warranty. 

 

When using a filter plate, avoid touching the bottom of the wells 
when wrapping the plate. Sample may wick or leak from the bottom 
of the well, causing problems when reading the plate. 

 

Make sure that you have added at least 125 µl of sample to all the 
wells specified in your plate template before starting a reading. If 
the Bio-Plex array reader attempts to draw sample from an empty 
well, air will be sucked into the sample loop and injected into the 
flow chamber. As a result, bubbles will form in the cuvette and 
interfere with the analysis. If this happens, perform a Remove 
Bubbles procedure (page 35) and rerun the Protocol. 

 

Shake the microplate on a plate shaker for 30 seconds prior to 
performing a reading. 

Running the Protocol 
When you have selected and reviewed all your Protocol options and prepared your 
microplate, click on the Start button. The Run Protocol dialog will open. 
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Figure 76. Run Protocol dialog. 

Enter your user name in the field. If you are using the Security Edition of the 
software in Secure Mode, your user name will be entered and cannot be changed. 

If your microplate has a barcode number or other type of ID number, enter it in the 
Plate ID field. 

Click on Eject/Retract Plate to insert the plate into the reader, and click on OK to 
begin the reading. 

If the Auto Save After Run checkbox is selected, you will be prompted to enter a 
name for the Results file to be generated. 

The following conditions may delay the start of a reading: 

• If the array reader optics have not warmed up, the reading will be delayed 
until warm up is complete. 

• If the pressure is too low in the fluidics system, you will receive a warning 
message prompting you to check the sheath fluid level, hose connections, 
etc. 

• If the platform heater is not at the specified temperature, a warning message 
will appear and you will be prompted to wait for the temperature to change. 

When the reading begins, the sample needle will lower, draw sample from a plate 
well, and retract to its original position. The sample will be drawn from the needle 
into the sample loop and the reading will begin. 
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After initial system pressurization (5–20 seconds), a typical well reading may take up 
to 2 minutes; in most cases, individual wells are read in a matter of seconds. 

Status Bar 

As the sample is analyzed, the status of the reading will be displayed in the status bar 
at the bottom of the Bio-Plex Manager window. 

 

Figure 77. Status bar during a reading. 

The status bar provides a running count of both the Number of beads and the Beads 
per second. Within these categories, the array reader keeps track of the following 
information: 

• The Region fields monitor only those beads that fall within one of the 
regions you selected in the Protocol (page 56). 

• The Gate fields monitor all beads that pass an internal discriminator "gate" 
designed to eliminate particles that are smaller or larger than a microsphere 
(including microspheres that are clumped or aggregated). 

• The Total fields report all particles measured by the array reader, including 
those that do not pass the internal discriminator gate. 

Manually Stopping a Reading 
While the sample is being read, the Start button will change to a Stop button in the 
Protocol window. You can click on Stop to cancel the reading. An alert box will 
notify you that you can generate a report with the incomplete results or rerun the 
Protocol as described on page 114. 

Generating Results from a Protocol 
The reading stops when you click on Stop, when an error stops the reading, or when 
all the samples have been analyzed. At the end of the reading, the sample needle 
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lowers and the syringe pump purges the sample loop and needle with sheath fluid, 
sending a fraction of sheath fluid (approximately 160 µl) back into each well. 

At the end of a complete reading, the Results will be automatically calculated and 
displayed. 

Note that the Results file will be automatically saved if you selected Auto save after 
run (page 92) in the Protocol. Otherwise, you must save your Results as a separate 
step (see the following chapter). 

To generate a new Results file from a Protocol, select New Results from Protocol 

 from the Run Protocol toolbar or the File menu. 

Histogram and Bead Map  
The histogram and bead map provide a graphical display of the raw data from a 
reading. These graphs are continuously updated during the reading in the Run 
Protocol window of a Protocol file. They also can be displayed after a reading in the 
Raw Data window of a Results file. 

The histogram and bead map share window space with the Raw Data table (see page 
109). If the histogram and bead map are not visible, click on the Show/Hide 

Histogram/Bead Map button  to display them. 
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Well number 
selected 

 

Figure 78. Histogram and bead map. 

You can see some of the rows of the Raw Data table below the histogram and bead 
map display if you maximize the window.  

During a run, the well number being read is displayed in blue in the upper left corner 
of the histogram. After the run, select the different wells to display by selecting rows 
in the table below the graphs.  

When viewing the histogram and bead map, you can choose to display all analytes, 
each analyte separately, or all beads that pass through the discriminator gate (see 
page 95). Make your selection using the pulldown menu above the histogram. 
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Figure 79. Selecting the analyte(s) to display. 

To print the histogram and/or bead map, click on the Print Histogram/Bead Map 

button . This opens a small dialog in which you can select the histogram, bead 
map, or both to print. 

Histogram 
The histogram plots the number of events per channel number for the selected well, 
analyte(s), and channel type. An event is generated when a particle such as a bead or 
aggregated beads passes through the path of the lasers. Each event generates signals 
in different channels: 

• The fluorochromes embedded in the bead(s) generate signals in the 
Classification 1 and Classification 2 channels. 

• The fluorescent molecules bound to the analytes generate a signal in the 
Reporter 1 channel. 

• The light scatter of the bead(s) generates a signal in the Doublet 
Discriminator channel.  The amount of light scatter is directly proportional 
to bead size. 

The signals are reported as channel numbers. In the histogram, the Y-axis is the 
events, and the X-axis is the channel numbers from 1 to 32766 for the selected 
channel type. 
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DD Gate Range 

The DD Gates range specified under the Run Protocol Advanced Settings (see page 
95) is shown on the histogram as two red lines perpendicular to the X-axis. In the 
Protocol window, you can change the DD gate range by positioning your cursor over 
the red lines and dragging them to the right or left. Note that this will also change the 
range as listed in the Advanced Settings dialog. 

 

Figure 80. Changing the DD gate range. 

You can show or hide the gate lines by right-clicking on the histogram and selecting 
Show or Hide from the Gate context menu. 

To reset the gates to their default values, click on the Restore Default Gates button 
 above the histogram. 

Selecting the Channel Type  

You can change the histogram to display different channel types. Click on the 
histogram with the right mouse button and select X-Axis from the context menu. 
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Figure 81. Histogram right-click context menu. 

From the X-Axis submenu, select from the following channel types: 

• The Doublet Discriminator channel measures the forward light scatter 
from particles as they pass through the red laser. Light scatter correlates to 
particle size; this channel allows you to discriminate single beads 
(“singlets”) from aggregated beads in the histogram. This is the default 
selection. 

• The Reporter 1 channel measures fluorescence from the reporter molecules 
bound to the analytes on each bead as they pass through the green laser. The 
amount of fluorescence per bead type is directly proportional to the amount 
of analyte present in the assay. This can be useful for viewing the 
distribution of the fluorescence signal of a particular analyte. 

• The Classification 1 channel measures fluorescence from the first 
classification dye embedded in each bead as it passes through the red laser. 

• The Classification 2 channel measures fluorescence from the second 
classification dye embedded in each bead as it passes through the red laser. 

Note that changing the channel type will change the channel numbers and the 
histogram display. 

Scaling the Histogram Data 

If the histogram is too big or too small to fit comfortably within the display range, 
click on the Auto Scale button  on the histogram toolbar. The height of the Y-axis 
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will change to better fit the data. You can also select this command from the right-
click context menu. 

Select Set Scale from the right-click histogram context menu to manually set the 
range of the Y-axis. In the pop-up box, enter the maximum number of events to 
display on the Y-axis. 

The default view of the data is log scale. From the toolbar, click on the Log/Linear 
button  to change the display from log to linear. Click again to return to log. 

Magnifying and Resizing the Histogram 

Click on the Zoom button  on the histogram toolbar to magnify the display. With 
Zoom selected, the cursor will change to a “hand” symbol  when you position it 
over the histogram. Drag the hand cursor to view different magnified regions of the 
histogram. 

Click on the Maximize button  to maximize the histogram portion of the window 
within the larger Protocol window. Click on the Restore button  to return the 
histogram to its default state. 
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Figure 82. Histogram maximized in the Protocol window. 

Bead Map 
The bead color map is a density dot plot of the events in a reading. Different colored 
dots in the map represent different numbers of events at those data points. 

In the default bead map, the X-axis is the Classification 1 channel and the Y-axis is 
the Classification 2 channel. These channels measure the embedded fluorochromes 
in each bead, which are used to identify the bead set and corresponding analyte. The 
resulting data point clusters in the map represent the different bead sets in the assay 
and their associated analytes 

¾ Each bead set generates a cluster of data points, rather than a single point, because of 
minute variations in fluorochrome levels and intensity among the beads in a set. 

The white areas on the map indicate the expected regions of the selected analytes. If 
you move your cursor over these areas, the name of the analyte will appear in a 
pop-up. The data point clusters should fall within these regions. 
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Figure 83. Bead map, with pop-up indicating the analyte region under the 
cursor.  

If one or more clusters do not fall within the white areas, it may indicate a problem 
with the beads such as photobleaching, or the analyte selections in the Protocol may 
be incorrect. If all the data clusters have shifted out of the white regions, there may 
be microbubbles in the cuvette. See Appendix 1 on page 167 for guidance with 
troubleshooting. 

In this way, the map can be used to confirm that the bead sets are correctly selected, 
measured and identified. 

Changing the X- and Y-Axes of the Map 

You can change the channel types of the axes. Right-click on the bead map and 
select one channel from the X-Axis submenu, and the other channel from the Y-Axis 
submenu. The available channels are: 

• Doublet Discriminator—This channel measures light scatter from the 
beads as they pass through the red laser. Light scatter correlates to particle 
size. 

• Reporter 1—This channel measures the reporter molecules bound to the 
analytes on each bead. 
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• Classification 1—This channel measures the first classification dye 
embedded in each bead. 

• Classification 2—This channel measures the second classification dye 
embedded in each bead. 

If you are developing your own assay, you may want to plot the Reporter 1 channel 
against the Doublet Discriminator channel to evaluate the distribution of the reporter 
signal. This yields information about the specificity of the antibodies in the assay. 

 

 

Figure 84. Changing the X-axis. 

Scaling the Bead Map Data 

The default view of the data is log scale. From the toolbar, click on the Log/Linear 
button  to change the display from log to linear. Click again to return to log. 

Magnifying and Resizing the Bead Map 

Click on the Zoom button  in the bead map toolbar to magnify the display. With 
Zoom selected, the cursor will change to a “hand” symbol  when you position it 
over the map. Drag the hand cursor to view different magnified regions of the bead 
map. 
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Click on the Maximize button  to maximize the bead map portion of the window 
within the larger Protocol window. Click on the Restore button  to return the bead 
map to its default state. 

Filtering the Bead Map Display 

Each colored dot in the bead map represents a certain number of events measured by 
the reader at that data point. Different colors are used to distinguish between 
different numbers of events. You can adjust the display so that data points with low 
numbers of events are not shown, or a certain number of events is required before the 
data point color changes. To access these settings, right-click on the bead map and 
select Options.  

 

Figure 85. Bead map filter level settings. 

¾ These settings only change the bead map display, and do not affect the underlying 
data in any way.   

First, enter a number in the Level Multiplier field. This number is used 
exponentially to determine the number of events required before a data point changes 
color. For the default value of 2, the color level will change at 2 events, 4 events, 8 
events, 16 events, etc. 

If you want to filter lower numbers of events from the display, select the Filter 
Levels checkbox and use the arrow keys next to Display above level to select the 
exponent level below which no data points will be displayed. For example, if the 
Level Multiplier is set to 2, and Display above level is set to 3, data points are not 
displayed until 8 or more events are registered; the first color level occurs at 8 
events, the second color level occurs at 16 events, the third color level occurs at 32 
events, etc. 
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The color levels in the display are, in order, dark blue, purple, dark green, light blue, 
blue, light green, orange, black, and brown. 

Raw Data Table  
The Raw Data table displays the raw numerical data of a reading, as well as all 
instrument settings and information related to the system hardware and software used 
in the reading (version numbers, voltage, temperature, gain, etc.). 

¾ Note that the instrument hardware and software information previously included in 
the Run Info window is now provided in the Raw Data table. 

This table is available in both the Run Protocol window and in the Raw Data 
window of the Results file. (Note that you can only print and export the Raw Data 
table from a Results file, not a Protocol window. See page 123.) 

The first few lines of this table are visible below the bead map and histogram. 
Alternatively, hide the bead map/histogram display by clicking on the Show/Hide 

Histogram/Bead Map button  to maximize the table. 

 

Figure 86. Raw data from a reading. 
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During a reading, the table is filled in line by line as each well is read. After the 
reading is complete, all the data is displayed. 

In the table, the fluorescent intensities (FI) of the analytes you selected are listed for 
each well number. 

¾ During a reading, the Bio-Plex array reader will always detect all the analytes in the 
sample, including any that you have not selected. However, analytes that were not 
selected in the Protocol will not be included in the table, even if they were detected. 
After a reading, you can go back and change your selections under Select Analytes, 
and the new analytes, if detected, will appear in the table. 

For on-line Help information about the Raw Data table, click on the Display Help 
for Table Legend button . 

Bead Statistics 
To display statistical data for the individual beads as well as the entire well, click on 
the Show/Hide Bead Statistics Columns button  on the table toolbar. The 
number of beads collected for each analyte will be displayed in parentheses after the 
analyte fluorescent intensity. 

 
Fluorescent intensity Bead count  

Figure 87. Analyte fluorescent intensity and bead count. 

With Show/Hide Bead Statistics Columns selected, the following columns are also 
displayed: 

• Total—Total bead count in the well. 
• Region—Number of beads that fell within defined regions. 
• Gate—Number of beads that passed the DD gate (see page 95). 
• % Agg Beads—Percentage of aggregated beads in the well  

(100 – (Gate/Total*100)). 
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Figure 88. Well data.  

¾ The number in the Region column will be flagged by an asterisk (*) if that well did 
not acquire the number of beads per region specified for the reading. 

Sampling Error Codes 
During a reading, the Bio-Plex system is continuously monitoring the flow of beads, 
the bead count, the bead regions, and the platform temperature. The Sampling Errors 
column reports errors in any of these areas for each analyte. These errors will be 
reported in the table even if you chose not to pause the run due to an error condition 
(see page 93). 

The sampling error codes in the column are listed below. 

Error Code: Indicates: 

1 Low bead number detected in the well 
2 Aggregated beads detected in the well 
3 Bead classification efficiency problem detected in the well 
4 Region selection problem detected in the well 
5 Platform temperature problem detected 

 

Raw Data Display Options 
To select the columns to display in the Raw Data table, as well as other display 

settings, click on the Raw Data Display Options button  or select the command 
from the Table Options menu. 

111 



Bio-Plex Manager User Guide  

 

Figure 89. Raw Data Display Options dialog. 

In the Raw Data Display Options dialog, select the columns to display using the 
checkboxes. You can also choose between predefined report settings by selecting 
Standard or Diagnostic in the Report Scheme field; these selections will display 
different sets of columns. 

Select the Show Bead Region Counts and Show Histogram and Bead Map 
checkboxes to set these display options as the default for the Raw Data table. 

Select the Save Settings as Default for New Protocol checkbox to use the 
selections in this dialog as the default for new Protocol files. 

Set Number Format 

In the Raw Data Display Options dialog, click on the Set Number Format button to 
select the number format for each column in the Raw Data table. 
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Figure 90. Set Column Number Format dialog. 

In the dialog, select the column from the pulldown list, then specify the number of 
decimal places for the value in that column in the Decimal Places field. Select the 
Scientific Notation checkbox to display the number in scientific notation. Select the 
Same Number Format for All Columns checkbox to use the selected number 
format for all the columns. 

¾ Note that changing the number format only changes how the numbers are displayed 
and printed, and does not affect calculations in any way. 

Click on OK to make the changes, or Reset Defaults to return all columns to their 
default number formats. 

Other Table Formatting 
To display the description of each sample in the table, click on the Show/Hide 
Description Column button  above the table. The Description column will be 
displayed. 

To automatically size the columns fit the width of the text, click on the Autofit 
button  on the toolbar. 
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Copying the Raw Data 
You can copy the contents of the table to the Windows clipboard. Select rows, 
columns, cells, or the entire table, then select Copy from the Edit menu. The values 
you copy can be pasted into other Windows® applications.  

Rerun/Recovery Mode 
After a reading has stopped—because of an error or user intervention, or because the 
reading is complete—the Rerun/Recovery Mode checkbox in the Run Protocol 
window will be selected. This allows you to rerun some or all of the samples. 

With Rerun/Recovery Mode selected, checkboxes will appear next to each well 
number in the Run Protocol table. Select the checkboxes next to the wells that you 
want to read again. 

 

Figure 91. Selecting wells to rerun. 

¾ To rerun wells in a filter plate, you must first vacuum the excess fluid from the wells 
and resuspend the remaining beads in 125 µl. (The beads will remain on top of each 
filter plug after vacuuming.)  
 
Vacuum the wells of the filter plate using the vacuum filter apparatus and resuspend 
the beads in each well with 125 µl of resuspension buffer. See the Bio-Plex Cytokine 
assay manual for detailed instructions. 

Each well may be read twice without adversely affecting the results. 

Because there are fewer beads in a well that has already been run once, be sure to 
select 100 beads per region or fewer in the Run Protocol settings (see page 91). Also, 
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click on the Advanced Settings button and deselect the Low bead number error 
condition checkbox (page 91). Otherwise, a low bead error may stop the reading. 

When you are ready, click on Start to begin the reading. 
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8. Analyzing the Results 

Results Files  
After a reading is complete, a Results file is generated and automatically opens. The 
Results file contains the data from a Bio-Plex reading, the Protocol parameters used 
to collect that data, and analysis tools for interpreting the data. It includes all the 
information necessary to analyze raw Bio-Plex data, including a description of the 
assays, well types, concentrations, dilutions, and the regression method used for 
calculating the concentrations of unknowns from standards. It also includes 
information about the instrument and the run conditions at each well at the time of 
data acquisition. 

In the Results file, you can change many of the parameters copied from the original 
Protocol file—including the plate format, analyte selection, standards info, etc.—and 
recalculate the results. However, you can only change the parameters of wells that 
have already been read, and you can only calculate results based on the analytes that 
were present in the sample. 

Note that the Results file is automatically saved after a reading if you selected Auto 
save after run in the Protocol window. Otherwise, you must save your Results file 
as a separate step. 

To generate a Results file from an incomplete reading or a previous reading, open the 
Protocol file that contains the raw data for that reading and select New Results from 
Protocol  from the Run Protocol toolbar or the File menu. 

Opening a Results File 
To open an existing Results file, click on the Open button  on the Quick Guide or 
main toolbar or select Open from the File menu. Locate and select the file using the 
standard Windows Open dialog. 
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Standard Results files have the file extension *.rbx. Secure Results files, created 
using Bio-Plex Manager Security Edition, have the extension. *.srbx. See page 155 
for more information about Secure files. 

¾ Secure Results files can only be opened as read-only files using the standard (non-
Security Edition) version of Bio-Plex Manager. 

¾ Results files created or modified by Bio-Plex Manager 4.0 cannot be opened by 
earlier versions of the software. 

Saving a Results File 
To save a Results file, with the file open click on the Save button  on the main 
toolbar or select Save or Save As from the File menu. 

Reducing the Size of a Results File 

Results files that include all the data from a reading can be very large 
(>5 megabytes). Much of this file size is due to the raw bead event data from the 
reading, which is used to generate the bead map and histogram displays. If you 
require a smaller file size (e.g., to send via email), you can save a copy of the file 
without this raw bead event data, but with the other numerical data from the reading 
intact. 

¾ We strongly recommend keeping a copy of the original Results file with the raw 
bead event data intact. This data is necessary for changing the DD gate range in the 
Results file (see page 122), and can also be exported in XML file format (see 
page 145) for further analysis. 

In the Save As dialog box, select the Compressed mode checkbox to save the 
Results file without the bead map and histogram data. All other data will be 
preserved. 
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Select this checkbox 
to reduce the size of 
the Results file 

 

Figure 92. Save As dialog for Results files. 

¾ Note that this compressed file option is not available for Secure Protocol files 
generated using the Security Edition of the software (see page 155). 

 

Results Window 
The Results window is divided into subwindows, each containing different options 
for viewing, formatting, and calculating your data. 
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Click on these 
buttons to view 
and calculate 
results. 

Click on these buttons to review/change the original Protocol settings. 

Figure 93. Results window. 

Navigate among the different subwindows using the buttons along the left side of the 
Results window: 

• Raw Data  (see page 123). 

• Report Table  (see page 125). 

• Standard Curve  (see page 138). 

Viewing/Changing the Protocol 
Settings 

In the Results window, you can review and in some cases change the plate 
formatting, analyte selections, sample concentrations, etc., from the original Protocol 
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file to display different data or recalculate data in the Results file tables. These 
controls are located in the toolbar across the top of the Results window. 

¾ Any changes that you make in the Results file will not change the original Protocol 
file or the data from the reading. They will only change how that data is displayed in 
the Results file tables. 

Click on the Describe Protocol button  in the Results toolbar to review or 
change the description of the Protocol, as described on page 55. 

Click on the Select Analytes button  in the Results toolbar to review the analyte 
selection or select different analytes, as described on page 55. 

¾ During a reading, the Bio-Plex array reader will always detect all the analytes in the 
sample, including any that you have not selected. However, analytes that were 
detected but not selected will not appear in the final reports and tables. After a 
reading, you can go back and correct your analyte selections, and the detected 
analytes will appear in the tables. 

Click on the Format Plate button  in the Results toolbar to review or change the 
formatting of the plate. Plate formatting is described on page 61. 

¾ Only formatted wells are read by the Bio-Plex array reader. You must define all the 
wells that you want to read before running a Protocol. However, you can change the 
formatting of a defined well (e.g., from unknown to standard) after a reading, and the 
analysis of that well will change. 

Click on the Enter Standards Info button  in the Results toolbar to review or 
change the concentrations of the standards, as described on page 73. 

Click on the Enter Controls Info button  in the Results toolbar to review or 
change the concentrations of the controls, as described on page 84. 

Click on the Enter Sample Info button  in the Results toolbar to review or 
change the sample information, as described on page 87. 
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Changing the DD Gate Range 
You can change the DD gate range (see page 95) in the Results file and recalculate 
the data based on the new range. Note the original DD gate range set in the Protocol 
file and used during the reading will be preserved and can be displayed in the Raw 
Data table. 

To reset the DD gate range, go to the Edit menu, open the Reanalyze Results 
submenu, and select Change DD Gates. The Change DD Gates dialog will open, 
displaying the histogram and bead map with controls for changing the DD gate 
range. (See page 99 for a complete description of other histogram and bead map 
controls.) 

 

Figure 94. Change DD Gates dialog. 

In the Change DD Gates dialog, first select the well that you want to change or select 
the Same DD Gates for All Formatted Wells checkbox. Also, you can select a 
specific analyte, all gated analytes, or all analytes from the pulldown menu above the 
histogram. Then either drag the red dashed lines in the histogram display to adjust 
the DD gates, or enter new values in the DD Low and/or DD High fields and click 
on the Update Gates button. 
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When you have made your changes, click on OK. The data in the Raw Data table 
(see next section) will be recalculated based on the new settings. 

Raw Data  
The Raw Data window in the Results file includes the same histogram and bead map 
and numerical Raw Data table as in the Run Protocol window. These features are 
described in the previous chapter on the following pages: 

• Histogram and bead map—page 99. 
• Raw Data table—page 109. 

 

Figure 95. Raw Data window in Results file. 

The Raw Data window in the Results file includes additional exporting and printing 
functions not available in the Protocol window. 
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Setting the Plate ID 
If you have an identification number for the microplate used in a reading, you can 
specify the ID number in the Results file. Right-click anywhere in the Raw Data 
table and select Set Plate ID from the context menu. 

            

Figure 96. Set Plate ID dialog. 

In the dialog, enter the plate ID number in the Plate ID field. If you want to associate 
the same ID number with all the wells in the reading, select Apply Plate ID to All 
Wells checkbox. If you want to associate different ID numbers with different wells, 
select the well for this number from the Well pulldown list. Click on OK to save the 
changes. 

The plate ID number is displayed for each well in the Raw Data table. 

Exporting the Raw Data 
To automatically export your raw data to Microsoft® Excel, click on the Export to 

Excel button  in the toolbar or select the command from the File menu. This 
command will automatically launch Excel and display a spreadsheet containing your 
data. 
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Figure 97. Example of an Excel spreadsheet with exported data. 

You can also export the raw data to a text file. With your raw data displayed, go to 
the File menu and select Export Table to File. This command will open a Save As 
dialog box in which you can specify a file name and location for the text file. 

¾ You can copy any or all values in the table to the Windows clipboard. Select the 
entire table, or the desired rows, columns or entries, and select Copy from the Edit 
menu. The values you copy can be pasted into other Windows applications.  

Printing the Raw Data 

You can print the Raw Data table using the Print command  on the main toolbar 
or File menu. Print Preview on the File menu displays the table as it will appear in 
the printout. 

Report Table  
The Report table provides detailed information about each of the analytes in your 

samples. Click on the Report Table button  to open the Report table window. 
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Select analyte from the pulldown list 

Figure 98. Report table. 

First, select the analyte that you want to review from the Analyte pulldown list 
above the table. All the data for that analyte in each defined well of the plate will be 
displayed in the table. 

For on-line Help information about the Report table, click on the Display Help for 

Table Legends button . 

Report Table Columns 
The columns in the table show the data for the selected analyte for each well or 
replicate group of wells. 

The available Report table columns are listed below: 

• Type—Sample type (unknown, standard, blank, etc.) and number, based on 
plate formatting. 

• Well—Well number; all wells are listed for a replicate group (see next 
section). 

• Outlier—Contains a checkbox for flagging the well or group of wells as an 
outlier. See page 131. 
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• Description—The description you entered for each standard, control, or 
sample in the Protocol. Click on the Show/Hide Description Columns 
button  to view or hide this column. 

• FI—The median fluorescent intensity of the selected analyte. 
• FI – Bkgd—The median fluorescent intensity minus background (measured 

using the defined blank wells) of the selected analyte. 
• Std Dev—The standard deviation of a replicate group of wells. 
• Std Err— The standard deviation of a replicate group of wells divided by 

the square root of the number of replicates. 
• %CV— The coefficient of variation of a replicate group of wells. If this 

value is high, you may want to review the individual FI values and select 
the appropriate member of the replicate group as an outlier (see next 
section). 

• Obs Conc—The observed concentration of the selected analyte, calculated 
from its fluorescent intensity and the standard curve. Note that the observed 
concentrations of standards are back-calculated from their fluorescent 
intensities and the standard curve. 

• Exp Conc—The expected concentration of the selected analyte standard or 
control, as specified in the Enter Standards Info window or Enter Controls 
Info window, respectively. 

• (Obs/Exp)*100— The recovery rate for the observed versus expected 
concentrations of the standard or control. See page 132. 

• Conc in Range—An observed concentration (see above) that falls within 
the range of standard concentrations given a specified recovery range (see 
page 82). Values outside the range are flagged as ***.  

• Group—The defined group of the selected well (see page 70). 
• Ratio—The ratio of the FI values of a member/reference or 

reference/member in a group (see page 70). 
• Dilution—The specified dilution factor of the selected analyte. 
• Bead Count—The number of beads counted in region for the selected 

analyte. 
• Bead Mean—The mean fluorescent intensity of the beads counted in region 

for the selected analyte. 
• Bead Std Dev—The standard deviation of the bead mean. 
• Bead Std Err—The standard error of the bead mean. 
• Bead %CV—The coefficient of variation of the bead mean. 
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• Trimmed Mean—The bead mean excluding the top 5% and bottom 5% of 
fluorescent intensities. 

• Trimmed Std Dev—The standard deviation of the trimmed mean. 
• Trimmed Std Err—The standard error of the trimmed mean. 
• Trimmed %CV—The coefficient of variation of the trimmed mean. 
• Sampling Errors—Error codes for a reading. See page 111. 

Report Table Options 
To select the columns to display in the Report table, as well as other display settings, 

click on the Report Table Options button  or select the command from the 
Table Options menu. 

 

Figure 99. Report Table Display Options dialog. 
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In the Report Table Display Options dialog, select the columns to display using the 
checkboxes. You can also choose between predefined report settings by selecting 
Quantitative or Qualitative in the Report Scheme field; these selections will 
display different sets of columns. 

¾ The predefined set of Quantitative columns are designed to be used with cytokine 
assays, while the Qualitative columns are designed to be used with phosphoprotein 
assays. 

Under Organize samples by, you can group the rows in the Report table by Type 
(standards, controls, unknowns, etc.), Group (if defined), or None. Note that Type 
and Group selections will override the Sort function in the Report table (see page 
133). For example, if you select Type organization, any sorting you do will be within 
each type. 

To review the data for each well in a replicate group (see page 128), select the 
Expand Replicate Info option. 

To hide error codes in the table such as OOR, ***, and ----, as well as * before 
concentration values, select the Exclude table error codes checkbox. 

Select the Save Settings as Default for New Protocol checkbox to use the 
selections in this dialog as the default in Results files generated from new Protocols. 

Set Number Format 

In the Report Table Display Options dialog, click on the Set Number Format button 
to select the number format for each column in the Report Table. 
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Figure 100. Set Column Number Format dialog. 

In the dialog, select the column from the pulldown list, then specify the number of 
decimal places for the value in that column in the Decimal Places field. Select the 
Scientific Notation checkbox to display the number in scientific notation. Select the 
Same Number Format for All Columns checkbox to use the selected number 
format for all the columns. 

¾ Note that changing the number format only changes how the numbers are displayed 
and printed, and does not affect calculations in any way. 

Click on OK to make the changes, or Reset Defaults to return all columns to their 
default number formats. 

Replicate Groups 
If you have defined multiple wells as a replicate group in the Format Plate window, 
the wells will be listed together in the Well column, and mean data values for those 
wells will be reported in the relevant columns for the selected analyte (unless the 
wells have been flagged as outliers; see page 131). 

 

Figure 101. Example of a standard with two replicate wells (A11 and A12). 
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To review the data for each well in a replicate group, click on the Show Replicates 

button . 

 

Figure 102. Expanded data for replicate wells. 

The mean values as well as the values for the individual wells will be reported for 
each replicate group. 

Selecting Outliers 
In some cases, you may want to exclude a well or replicate group of wells from 
statistical calculations (e.g., when the CV% of a set of replicates is high, or the 
observed concentration of an analyte is out of range). The Outlier column in the 
Report table window allows you to flag a well or replicate group of wells as an 
outlier. 

Click on the Show/Hide Outliers Column button  in the toolbar to show or hide 
the column. 

Each row in the column contains a checkbox. When you select the checkbox, the 
data for the selected analyte in the well is excluded and the table is automatically 
recalculated. 

Note that flagging a well as an outlier for the selected analyte does not flag it as an 
outlier for all analytes. To do this, right click on the outlier checkbox for the well, 
and select Set Outlier (All Analytes) from the context menu. 
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Figure 103. Selecting a well as an outlier for all analytes. 

Now the well data for all analytes will be excluded from calculations. To remove the 
outlier flag for all analytes, right-click on the well select Clear Outlier (All 
Analytes) from the context menu. 

If you flag a replicate group of wells as an outlier, data for the entire group is 

excluded. If you click on the Expand Replicates Info button , you can flag each 
well in the group as an individual outlier. If you do this, the outlier checkbox for the 
entire group will appear checked and grayed out, indicating that part of the group has 
been flagged. 

 

Group checkbox 
appears gray 
and selected 

Figure 104. Flagging a single well in a replicate group as an outlier. 

Obs/Exp*100 Column 
Because the standard curve (page 138) is critical for calculating the concentrations of 
unknowns, the Obs/Exp*100 column in the Report table allows you to assess how 
well the curve fits the standards. This column is also used with controls (page 84) to 
determine the overall accuracy of an assay. 

To display this column, click on Report Table Options  and select the 
(Obs/Exp)*100 checkbox. 

The (Obs/Exp)*100 column shows the recovery rate for the observed versus 
expected concentration of each standard. This number should fall within the recovery 
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percentage range selected in the Enter Standards Info window (see page 83). For 
example, if you selected a recovery range of 80–120%, the observed (back-
calculated) concentration of a standard should be within 80–120% of the expected 
concentration. Values outside this range are flagged in the Conc in Range column. 

Conc in Range Column 
The concentration in range column (Conc in Range) provides a method for 
determining which unknown concentrations are reliable based on the recovery range 
of the standards (see previous section). This column shows only observed 
concentration values that fall within the range of valid standards; values that do not 
fall in the range are displayed as ***. (The concentration in range values of the back-
calculated standards are also shown, for comparison purposes.) 

 

Back-calculated standard 
concentrations within a specified 
recovery percentage range of 80–120% 

Concentrations of unknowns within the 
range of valid back-calculated standard 
concentrations  

Concentrations of unknowns outside the 
range of valid back-calculated standard 
concentrations 

Figure 105. Conc in Range column. 

For example, if only standard concentrations from 1.9 to 8,100 ρg/ml fall within the 
specified recovery range, then only unknown concentrations that fall within this 
range will be displayed in the Conc in Range column. 

Table Formatting 
To sort the data in the table alphanumerically, click on the heading of the column 

that you want to sort by, then click on the Sort button . Clicking twice will invert 
the order. 
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To highlight the divisions between the unknowns, standards, controls, etc. in the 

report, click on the Organize by Type button . With this button selected, any 
sorting you do will be within each type. 

To highlight the divisions between defined groups (see page 70) in the report, click 

on the Organize by Group button . With this button selected, any sorting you do 
will be within each group. 

To automatically size the columns to fit the width of the text, click on the Autofit 
button  on the toolbar. 

Copying the Report Table 
You can copy the contents of the table to the Windows clipboard. Select rows, 
columns, cells, or the entire table, then select Copy from the Edit menu. The copied 
values can be pasted into other Windows applications. 

Exporting the Report Table  
To export the data in the Report table to an Excel spreadsheet or workbook, or tab-

defined text file, click on the Export Report Table button  in the toolbar. 

134 



 Chapter 8.  Analyzing the Results 

     

Figure 106. Table Export Options dialog. 

The Table Export Options dialog will open. 

Export Format 

Select Table per Analyte to display all the data for each analyte on an individual 
spreadsheet. 

Select Table per Column to display one column of data (e.g., FI) for all the analytes 
on an individual spreadsheet. 

Select 96-Well Plate to display one type of data for each analyte in a spreadsheet, 
laid out like the wells in a 96-well plate (rows A–H and columns 1–12). Note that 
this selection will export only one type of data at a time. 

For additional export options, click on the Advanced Export Options button. 

Advanced Export Options 

If you selected 96-Well Plate or Table per Column above, select the data to export 
under the Report Table Column to Export pulldown list. 
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If you selected 96-Well Plate or Table per Analyte above, under Export Source, 
select Selected Analyte to export only the data for the currently selected analyte in 
the Report table or All Analytes to export the data for all analytes in the table. 

Under Export Destination, select Excel Workbook to export the data to a 
Microsoft® Excel file, or Text File (Tab Delimited) to export it to a tab-delimited 
text file (see Figure 107 for an example). 

If you selected Excel Workbook and will be generating multiple tables of data, 
select the Use Multiple Worksheets checkbox to export each table to a different 
worksheet within the Excel workbook. Otherwise, all tables will appear on the same 
worksheet. 

 

Figure 107. FI - Bkgd data for multiple analytes exported to a tab-delimited  
text file, 96-well plate format. 

Select the Exclude Column Headers/Footers and Page Headers/Footers to 
exclude this information from the exported file. 

The error codes symbols in the Report table (OOR< >, ***, ----, * before 
concentration values) can interfere with macros in some types of spreadsheets, 
including Excel spreadsheets. Select the Exclude Table Error Codes checkbox to 
exclude these symbols from the exported file. If this option is selected, table cells 
with error codes will be exported as empty cells. 

If you are exporting to Excel, Microsoft® Excel will automatically launch when you 
click on OK and a spreadsheet will be created. 
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Figure 108. Example of an Excel spreadsheet, Table per Analyte format. 

 

Figure 109. Example of an Excel spreadsheet, Table per Column format. 

If you are exporting to a text file, a Save As dialog will open when you click on OK. 
Select the desired directory and name and click on Save to complete the operation. 

137 



Bio-Plex Manager User Guide  

Printing the Report Table  
You can print the Report table for the selected analyte using the Print command  
on the main toolbar or File menu. You can print the Report table for all analytes 

using the Print All Analytes command  on the main toolbar or File menu.  

Print Preview displays the table as it will appear in the printout. 

Standard Curve  
The Standard Curve window displays the standard curve for each standard analyte in 
the Results file, and allows you to change the regression model as well as various 
curve display controls for each analyte. (Curve settings are initially selected in the 
Enter Standards Info window in a Protocol; see page 73.) 

Click on the Standard Curve button  to open the Standard Curve window. 

 

Figure 110. Standard curve. 
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In the graph, standards defined on the current plate will be displayed as blue squares, 
while external standards will be displayed as red circles. If both types of standards 
are used in the Results file, both will be displayed on the curve. Outliers and partial 
outliers will be displayed on the curve as indicated in the legend below the curve. 

The equation for the selected regression method as well as some curve fit statistics 
(R2, fit probability, residual variance) will be displayed below the standard curve, if 
possible. Equations for standards defined on the current plate are shown in blue, 
while equations for external standards are displayed in dark red. Any curve fitting 
errors will also be displayed below the curve in red. 

Use the Analyte pulldown list to display the curve for a selected analyte. 

Above the curve, use the Labels pulldown list to select from a variety of different 
labels for the points in the curve. If both external and current standards are displayed 
in the graph, labels will only be displayed for the external standards. 

Use the Error Bars pulldown list to select from several different error bars (e.g., 
1-Std Dev, 2-Std Err) to plot for each point in the curve. If there is only one replicate 
for a point, the bar will have a value of zero. If both external and current standards 
are displayed in the graph, error bars will only be displayed for the external 
standards. 

Use the Regression Type pulldown list to choose from seven different regression 
models to generate the standard curve (see next section). 

¾ Changing the regression type will automatically recalculate all the data in the Report 
table. If you are unsure whether your data has been recalculated, select Refresh 
Calculations from the View menu. 

Use the Axis Transformation pulldown list to select the standard curve axis scale. 
Four different combinations of linear and logarithmic are available. 

¾ Changing the axis transformation will only change the display of the curve—not the 
calculated data. 

You can use a different regression model for each analyte. Deselect the Same 
regression type for all analytes checkbox, select a different analyte from the 
pulldown list, and select the regression type to use for that analyte. 
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Select the Swap XY Axes checkbox to change the X and Y axes of the curve. 

To display all the data for each standard sample point in the curve, position your 
cursor over the point. A pop-up box will list the data. 

 

Figure 111. Pop-up data for a standard sample point in the curve. 

Regression Methods 
There are seven regression methods for calculating the standard curve: 

• Logistic-5 PL 
• Logistic-4 PL 
• Linear 
• Cubic spline 
• Point-to-point 
• Linear (semi-log) 
• Point-to-point (semi-log) 

The minimum number of non-zero standards required for using each type of 
regression method is shown in the following table: 

Method Minimum number of standards 

Logistic-5PL 6 

Logistic-4PL 5 

Cubic spine 4 

Linear (linear and semi-log) 2 

Point to point (linear and semi-log) 2 
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Figure 112. Example of Logistic-5PL curves for standards on the current 
plate and external standards. 

If you do not have enough points for the selected method, an error message will be 
displayed in red below the standard curve. 

Logistic-5PL 

This version of the five parameter logistic equation has been developed by Brendan 
Scientific, creator of StatLIA immunoassay software. The Logistic-5PL regression 
type yields the best results for most assays; therefore, this is the default in Bio-Plex 
Manager. However, there may be cases where the Logistic-4PL equation gives 
slightly better results. 

The Logistic-5PL equation is: 
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where: 

x is the concentration, 
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y is the response, 

a is the estimated response at zero concentration, 

b is the slope of the tangent at midpoint, 

c is the midrange concentration or midpoint, 

d is the estimated response at infinite concentration, and 

g is an asymmetry factor. 

Logistic-4PL 

In certain cases, where the curve is a perfectly shaped “S,”  the Logistic-4PL 
regression may give better results.  However, the Logistic-5PL regression has been 
shown to be the most robust routine for most Bio-Plex assays. 

The Logistic-4PL equation is: 
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where: 

x is the concentration, 

y is the response, 

a is the estimated response at zero concentration, 

b is the slope of the tangent at midpoint, 

c is the midrange concentration or midpoint, and 

d is the estimated response at infinite concentration. 

Linear 

The Linear equation is: 

bxay +=  

Where a is the intercept and b is the slope of the line. 
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The simplest method for determining concentrations from a standard curve is to 
construct a plot using the linear portion of the response curve.  The R-squared value 
may be used to determine the overall goodness of the linear fit.  A linear regression 
with an R-squared value of greater then 0.99 is considered a very good fit. 

The primary advantage of this method is that it is extremely simple.  The primary 
disadvantage is that the linear range of concentrations is relatively small compared to 
that which may be obtained using nonlinear regression. 

The Linear curve is available in linear and semi-log versions. 

Cubic Spline 

Cubic spline curves are smooth curves that go through every data point. The model is 
a cubic polynomial on each interval between data points. In some cases, a spline 
curve can work well as a standard curve for interpolation. However, because the 
curve is calculated individually for every pair of points, it does not correspond to any 
single equation. 

The cubic spline curve is applicable to a wide range of assays; however, there are no 
built-in biochemical restrictions on the curve shape, and values cannot be 
extrapolated.1,2

Point-to-Point 

A single equation is not available for the point-to-point method. The slope of each 
segment of the curve between data points is calculated independently. 

The Point-to-Point curve is available in linear and semi-log versions. 

Linear versus Logistic Regression Methods 
In terms of performance, the primary difference between linear and logistic 
regression models is that the linear range in which concentrations can be accurately 
predicted is much smaller.  In most cases, the overall response of the assay is best 

                                                           
1 The Immunoassay Handbook. David Wild, Editor. Nature Publishing Group, New York, NY. 
(2nd Edition, 2001). 
2 The GraphPad Guide to Nonlinear Regression. Harvey Moltusky, Ph.D. GraphPad Software, San 
Diego, CA. 
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modeled using a logistic fit and the Logistic-5PL model will yield the best results. 
For more information, see Bio-Rad bulletin 2861, available on our Web site 
(www.bio-rad.com) or from Technical Support (see page 13). 

Nevertheless, in certain cases you may want to use linear regression to analyze the 
data.  For most cytokines, the linear portion of the curve is well within the biological 
range of concentrations expected for patient samples.  Thus, for serum the linear 
regression may be useful. The main advantage of a linear regression is that fewer 
points (as few as 2) can be used.   

Copying the Standard Curve 
To copy a bitmap image of the curve to the Windows clipboard, click in the 
Standard Curve window and select Copy from the Edit menu. You can then paste 
this image into your spreadsheets or other documents using the Paste command in 
your other applications. 

You can also copy the regression method equation from below the standard curve by 
dragging your cursor over the equation to highlight it, and then selecting Copy from 
the Edit menu or right-click context menu. 

Printing the Standard Curve 
You can print the standard curve for the selected analyte using the Print command 

 on the main toolbar or File menu. You can print the curve for all analytes using 

the Print All Analytes command  on the main toolbar or File menu. 

When you select a print command, a dialog box will open allowing you to specify 
the page layout of the printed curve. 

 

Figure 113. Print Standard Curve dialog. 
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The layout diagrams show the number of curves that can be printed on a page. If you 
are printing the curve for a single analyte, that curve will be sized based on the 
layout you select (e.g., the  layout will size the curve at one-quarter the full size 
of the page). The regression type will be printed below each curve. 

Select a layout and click on OK to display the standard Windows® Print dialog. 

XML Export 
You can export all the information in a Results file as an XML-formatted text file for 
data sharing, import into Laboratory Information System databases, and data analysis 
using other applications. 

¾ XML is a self-describing, universal file format compatible with a wide range of 
applications. 

The XML document generated by Bio-Plex Manager includes all the data stored in 
the Results file, including but not limited to: 

• Run parameters, including DD gate settings, instrument temperature 
settings, data limits, bead regions, etc. 

• Run conditions, including time stamps per well, error conditions during the 
run, actual temperature during acquisition by well, etc. 

• Complete data values and calculations (mean, median, standard deviation, 
coefficient of variation, etc.) per well 

• Complete Protocol information, including analytes selected, plate 
formatting, standard values, etc. 

• Raw bead event data (when selected) 
• Standard curve information, including mathematical models used, how well 

the data fit the curve, etc. 
• Instrument and software information, including version numbers 

To export the Results data in XML format, go to the File menu and select XML 
Document Export. 
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Figure 114. XML Export dialog. 

In the XML Export dialog, select the Exclude Raw Bead Event Data checkbox to 
exclude this information from the export file. 

Under Destination, specify whether you want to send the data to a file or display the 
data using another software application. 

If you select File, you can use the default file name and location, or click on Change 
File to specify a new file name and location. 

If you select Command Line, click on Select Application to locate the software 
application that you want to automatically launch when the file is generated. After 
you locate and select the application, you must include the string “&&XML&&” in 
the command line, in quotation marks, as shown in the following figure. 

 

Figure 115. Example of a command line string. 

When you have made your selections, click on OK. 
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Figure 116. Example of an XML document. 

You can set the default XML export settings using the XML Export Properties 
dialog. Go to the File menu and select XML Export Properties to open this dialog. 
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Figure 117. XML Export Properties dialog. 

This dialog is similar to the XML Export dialog, except that it sets the default XML 
export settings and default folder where XML files will be saved. These settings are 
used if you select the Auto XML Export After Run checkbox in the Advanced Run 
Settings dialog (see page 92). 

XML Schema File 

An XML schema file named Bio-Plex_1.xsd is included in the main Bio-Plex 
Manager application directory. This schema file can be used to automatically 
validate the XML file. 
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9. Bio-Plex Manager 
Security Edition 

Overview 
Bio-Plex Manager Security Edition works in conjunction with the built-in security 
features of the Windows® 2000 and Windows® XP Professional operating systems to 
provide a secure environment for the maintenance, verification, and tracking of all 
electronic records generated by the application. These records include Protocol and 
Results files, and the Calibration, Validation, and Instrument Operations Logs. The 
tools provided in the software include: 

• Access controls and authority checks via the use of user identification codes 
and passwords 

• Electronic record security via the use of protected directories 
• Time- and date-stamped audit trails 
• Electronic signature of electronic records (user authentication)  

When properly configured and administered, these tools ensure compliance with the 
rules for secure handling of electronic records as outlined in Title 21, Part 11 of the 
Code of Federal Regulations (CFR). 

Background on 21 CFR Part 11 

Effective August 20, 1997, the United States Food and Drug Administration (FDA) 
released Part 11 “Electronic Records; Electronic Signatures” of title 21 of CFR. This 
rule states the conditions under which the FDA considers electronic signatures and 
electronic records to be trustworthy, reliable, and equivalent to traditional 
handwritten signatures. 

Bio-Plex Manager Security Edition is designed to enable organizations and 
institutions using the Bio-Plex System to comply with the rules laid out under 21 
CFR Part 11. It enables system administrators to ensure that Bio-Plex Manager 
operates in compliance with 21 CFR Part 11 within a “closed system.” A closed 
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system is defined as “an environment in which system access is controlled by the 
persons who are responsible for the content of electronic records that are on the 
system” (Section 11.3 (b) (4)). 

Note that the security controls built into Bio-Plex Manager Security Edition must be 
properly configured and administered by the system administrator(s) in your 
organization. Otherwise, the Bio-Plex System will not be secure and will not be in 
compliance with 21 CFR Part 11. 

¾ Bio-Rad makes no claim that Bio-Plex Manager Security Edition is CFR compliant 
in and of itself, nor does it guarantee compliance for the user. Your organization 
must establish policies and standard operating procedures that work in conjunction 
with the tools provided by Bio-Rad to ensure compliance with 21 CFR Part 11. 

Standard Mode Versus Secure Mode 

Bio-Plex Manager Security Edition can run in standard mode, in which all the 
security and audit trail features are disabled and the software functions like the 
standard version of Bio-Plex Manager, or it can run in Secure Mode, with the 
security functions enabled. This chapter assumes that you are running the software in 
Secure Mode, unless otherwise noted. 

¾ When you are in Secure Mode, the status bar displays a “locked” symbol . When 
you are in standard mode, the status bar displays an “unlocked” symbol . 

System Requirements 

Bio-Plex Manager Security Edition has the same system requirements as the standard 
version, except that the security functions are not supported under the Windows® XP 
Home Edition operating system. The software must be installed on a computer 
running the Windows® 2000 or XP Professional operating system for full Secure 
Mode functionality. 

Installing and Starting Bio-Plex Manager Security Edition 

Security Edition is installed and starts up just like the standard version. After 
installation, the software will run in standard mode until an Administrator-level user 
(see next section) enables Secure Mode. 
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When you start the Bio-Plex Manager in Secure Mode, you will be prompted to log 
in with your user name and password. 

¾ User names and passwords must be set up on your computer or computer network as 
described in the Bio-Plex Manager Security Edition Configuration Setup Guide 
before you can use the application in Secure Mode. This guide is provided with your 
Security Edition license. 

Users, Passwords, and User Levels 
In Secure Mode, Bio-Plex Manager Security Edition requires that users log in with a 
user name and password to run the software. User names and passwords are set up 
by your Windows® system administrator as described in the Bio-Plex Manager 
Security Edition Configuration Setup Guide. 

¾ Contact your Windows® system administrator about issues regarding your user name 
and password. 

Each user is assigned to a particular user level. There are six user levels in Bio-Plex 
Manager Security Edition, and each level gives the user access to specific features 
and functions of the software. 

A table listing the specific features and functions accessible at each user level is 
provided in Appendix 4. The following is a general summary of each user level. 

• Administrator — Users at this level can enable or disable Secure Mode. 
Administrator-level users also can view log files. Access to all other 
features and functions of the software is restricted. 

• Supervisor — Users at this level have full access to all features and 
functions of the software, except that they cannot enable or disable Secure 
Mode. 

• Service — Users at this level have full access to all features and functions 
of the software, except that they cannot enable or disable Secure Mode. 

• Clinician 2 — Users at this level can perform instrument operations, run 
existing protocols, and view Protocol files, Results files, and log files. They 
can also change the number of unknown samples in the plate format (using 
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the Set Number of Unknown Samples command) and enter sample 
descriptions. All other access is restricted. 

• Clinician 1 — Users at this level can perform instrument operations, run 
protocols, and view Protocol files, Results files, and log files, but cannot 
change any settings. All other access is restricted. 

• Reviewer — Users at this level can view and sign Protocol and Results 
files, and can view log files. All other access is restricted. 

User Level Restrictions 

If you attempt to select a command or perform an action not allowed by your user 
level, you will receive a pop-up warning. In addition, many fields and settings that 
are restricted by your user level will appear grayed out in the application. 

User Information 

To display information about the current user, including user name, domain, full 
name, and access level, go to the Tools menu and select User Info. You can also 
click on the user name displayed in the application status bar. 

 

Figure 118. User Information dialog. 

Enabling and Disabling Secure Mode 
Only users with Administrator-level access can enable or disable Secure Mode. 
Enabling or disabling Secure Mode requires that you close all documents and restart 
the application. 
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When Secure Mode is enabled, the status bar will display the locked symbol. 

       

Figure 119. Status bar showing disabled (left) and enabled (right) Secure 
Mode status 

To enable Secure Mode, go to the Tools menu and select Preferences. In the 
Preferences dialog, select the Enable Secure Mode checkbox to enable Secure 
Mode, or deselect the checkbox to disable it. 

If your user name and password are set up on a Windows® network server, enter the 
network domain where they reside in the Domain to Be Used for Authentication 
field. Contact your Windows® system administrator if you are unsure of your 
domain. Note that only users set up on the domain you specify will be able to use the 
software. 

When you click on OK, you will be prompted to sign in as an Administrator-level 
user to authenticate the change. You will then need to restart the software. 

User Authentication 
Bio-Plex Manager Security Edition requires user authentication (entering a user 
name and password) at key points during operation. User authentication creates an 
electronic audit trail of user activity that cannot be altered or deleted. 

 

Figure 120. Log In dialog 
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Users are required to enter their user name and password when they: 

• Start the application 
• Start a reading 
• Unlock the application 
• Sign a document, such as a Protocol or Results file 

Different users may authenticate different operations. For example, a Clinician 1-
level user may be logged into Bio-Plex Manager, but a Supervisor-level user may 
enter his user name and password to authenticate a particular reading. Note that in 
this case, the Clinician 1-level user will remain logged into the application. 

Your organization must establish its own guidelines for user authentication of 
specific operations. 

Electronic Records 
Bio-Plex Manager Security Edition supports the creation and control of secure 
“electronic records,” as defined by 21 CFR Part 11. In Bio-Plex Manager, the 
following are electronic records: 

• Protocol files 
• Results files 
• Calibration Log (included in the bioplexdata.mdb file) 
• Validation Log (included in the bioplexdata.mdb file) 
• Instrument Operations Log (included in the bioplexdata.mdb file) 

These records are only accessible through Bio-Plex Manager and its associated 
utilities. 

File Security and Validation 
The files used by Bio-Plex Manager Security Edition cannot be opened or edited 
using other programs. Bio-Plex Manager will check the integrity and validity of a 
file each time the file opens. If a file becomes damaged or shows signs of tampering 
with an outside application, it will not open in Bio-Plex Manager. 

154 



 Chapter 9.  Security Edition 

Calibration, Validation, and Instrument 
Operations Logs 

These logs provide a permanent chronological record of all calibration, validation, 
and instrument operations events. You can view, copy, and print the data from these 
logs. They are available from the View menu in Bio-Plex Manager. 

If the application is in Secure Mode, each event in a log will include the name and 
access level of the user who performed/authorized the action. If the application is in 
standard mode, the event will be flagged as having occurred outside Secure Mode 
and the access level will be labeled as “unrestricted.” 

These logs are stored in a database file called bioplexdata.mdb, which by default is 
saved in the main Bio-Plex Manager application folder on your computer (you can 
specify a different location during installation). 

¾ Note that the bioplexdata.mdb database is not compatible with versions of Bio-Plex 
Manager earlier than 4.0. If you have an earlier version of the software, installing 
version 4.0 or higher will copy the data from your existing database (bioplex.mdb) 
into the new database. A copy of your old database will remain in the application 
folder. 

For more information about the Calibration Log, see page 33. 

For more information about the Validation Log, see page 42. 

For more information about the Instrument Operations Log, see page 48. 

Secure Protocol and Results Files 
Bio-Plex Manager Security Edition supports the creation of Secure Protocol and 
Results files. Secure files are documents that have been electronically “signed” by a 
user. Once signed, these files are controlled documents that cannot by overwritten by 
Bio-Plex Manager and that preserve a built-in audit trail of all saved changes. 
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Unsigned Protocol and Results Files 

When you create a new Protocol file in Bio-Plex Manager Security Edition, it is 
initially unsigned and is not a Secure file. Protocol or Results files created with 
previous versions of the software or created in standard mode are also unsigned, 
uncontrolled documents, and you will be notified that these files are not secure when 
you open them in Secure Mode. You can save and overwrite these files without 
restrictions and no audit trail will be generated for any changes. 

If you make changes to a signed Protocol or Results file and save them as a new file, 
the new file will not be signed; however, the audit trail (page 161) will be preserved 
in the new file and the file will remain a Secure file. 

¾ You cannot generate a new unsigned, uncontrolled Results file in Secure Mode; all 
Results files generated in Secure Mode must be signed. 

Signed Protocol and Results Files 

Protocol and Results files become Secure files when they are electronically signed 
using a user name and password. Once signed, these files become read-only; you can 
make changes to the file but they must be saved under a different file name. An audit 
trail of changes is built into each Secure Protocol and Results file. 

Secure Protocol files have the file extension *.spbx. Secure Results files have the file 
extension *.srbx. 

To sign a Protocol or Results file, go to the File menu and select Sign Document. 
The Electronic Signature dialog will open. (Note that this dialog will open 
automatically when a Results file is generated from a Protocol file.) 
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Figure 121. Electronic Signature dialog. 

In the dialog, the signing party enters their user name and password in the 
appropriate fields. (Note that this may be someone other than the current user.) The 
reason for signing the document must be entered in the text field. Typical reasons 
may include review, approval, responsibility, or authorship. 

When you click on OK, a Save As dialog will open. 

 

Figure 122. Save As dialog for Secure Protocol file. 
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Enter a name for the file or use the default name and click on Save. 

After a file has been signed, it is flagged as read-only and cannot be modified. Any 
subsequent changes must be saved as a new file. Also, any changes made to a file 
after it has been signed will generate an audit trail documenting each change, as 
described starting on page 161. 

A new file generated from a signed file can be signed again to verify and lock in any 
changes made to it. As before, the new signed file will be flagged as read-only and 
any subsequent changes must be saved under a new file name. 

Document ID Number and Signature 

Each signed Protocol and Results file has a unique document identifier (Document 
ID) number. To view this number, go to the File menu and select Document 
Properties. 

 

Figure 123. Document Properties dialog. 

The Document Properties dialog also provides information about the signature. 

The full name of the user who has signed the document is displayed in the title bar of 
the file window. 
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Figure 124. Signed and read-only status of file shown in title bar 

All printouts and exports from a signed document also include the signature and 
Document ID number. 

 

Figure 125. Example of a Document ID and signature in an Excel export file 

Clinician 2 Users: Adjusting the Number of Unknown 
Samples in a Protocol 

A Supervisor-level user can create a “master” Protocol file with a defined plate 
format, including a set number of unknown sample wells, and then a Clinician 2-
level user can open the Protocol and adjust the number of unknown samples to be 
read in a particular reading. This enables Clinician 2-level users to use the same 
Protocol file in multiple readings with different numbers of samples. 
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¾ Clinician 2-level users do not have access to the other plate formatting tools in 
Protocols. See pages 63–67 for information on defining unknown sample wells and 
replicates in Protocols. 

With the Protocol file open and the Format Plate window displayed, click on the Set 

Number of Unknown Samples button  in the formatting toolbar or select the 
command from the Format Options menu. 

In the Set Number of Samples dialog, the maximum number of unknown samples 
defined in the plate template will be noted next to the field. 

 

Figure 126. Set Number of Samples dialog. 

¾ The maximum number of unknown samples is determined by the number of 
formatted unknown sample wells and the number of wells per replicate group 
defined in the template. For example, a template with 48 wells defined as unknowns 
and four wells per replicate will have a maximum number of 12 samples. 

Enter the number of samples to use in a particular reading in the field and click on 
OK. The plate format will change to indicate the new number and layout of the 
sample wells. Only those wells will be read during a reading. 

Note that you can only specify the number of unknown samples using this 
command—not standards, controls, or blanks. 

If you save the Protocol file after changing the number of unknown samples, the 
number of samples you specified will become the new maximum number of samples. 
To preserve the original number of unknown samples, save the changed Protocol file 
under a different name. 
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Generating a Results File from a Protocol File 

The Results file must be signed before a reading can begin. In Secure Mode, the 
Auto Save After Run checkbox in the Run Protocol window (see page 92) is 
automatically selected and cannot be deselected. You will be prompted to sign and 
save the Results file at the start of each reading. 

¾ In Secure Mode, each reading, including reruns of plate wells, will generate a new 
Results file that cannot be overwritten. 

 

Figure 127. Electronic Signature required for a Results file before a reading 

You will also be prompted to sign and save the Results file if you select the New 
Results from Protocol command from the File menu (see page 117). 

Audit Trail 
Any changes made or actions performed after a Protocol or Results file has been 
signed will automatically generate an audit trail documenting each change/action. If 
you make changes to a signed, read-only file and save it as a new file, the audit trail 
will be preserved in the new file (with the signature of the previous file noted as part 
of the audit trail). Also, the audit trail for a Protocol file will be preserved in the 
Results file generated from that Protocol. 

All major actions and changes are audited. Examples of auditable actions include: 
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• Signing a file 
• Changing Protocol settings (plate format, analyte selection, etc.) 
• Changing the standard curve regression type, variance model, etc. 
• Flagging outliers 
• Performing readings (audited in the Results file) 

Minor changes that affect the display only, such as selecting different columns in the 
Report Table or changing the axis transformation in the Standard Curve, are not 
audited. 

Each change you make to a signed Protocol or Results file or a new file saved from a 
signed file must be documented in the Reason for Change dialog. The information in 
this dialog is used to generate the audit trail. The dialog opens automatically 
whenever you make a change and either save the document or switch between 
subwindows in the Protocol or Results file. 

 

Figure 128. Reason for Change dialog, used to generate the audit trail 
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The dialog notes the date and time of each auditable action and describes the 
change/edit made. You must enter a reason for each change in the bottom field. 

If you have made more than one change, use the Next and Back buttons to scroll 
through the changes. When you have entered a reason for each change, click on the 
Finished button. 

Viewing the Audit Trail 

To view the audit trail for a Protocol or Results file, go to the View menu and select 
Audit Trail. The audit trail is displayed in a subwindow of the Protocol or Results 
file. 

 

Figure 129. Audit trail for a Protocol file 

 

Figure 130. Audit trail for a Results file 
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The audit trail notes the date and time of each action, the user, the access level, the 
action, a description of the action (automatically generated by the software), the 
reason for the action (entered by the user), and the version of the software. 

The audit trail also notes each time the file has been signed. In the example in Figure 
131, note that each time the file was signed and made read-only, the audit trail was 
continued in the new file. 

 

New file: 
Human_Cytokines_002.spbx 

New file: 
Human_Cytokines_001.spbx 

New file: 
Human_Cytokines.spbx 

Figure 131. Example of a Protocol audit trail with signatures 

To display the complete contents of the Description and Reason cells in the table, 
you can hold your cursor over a table cell and the information for that cell will be 
displayed in a context pop-up box. Or you can click on the Expand Audit Entries 

button  in the audit trail window toolbar to expand all the cells. 

 

Figure 132. Example of a pop-up information box in the audit trail 

To copy the contents of the audit trail to the Windows® clipboard, click on the Copy 
to Clipboard button  in the window toolbar. To print the audit trail, click on the 
Print button . 
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Protected Directories 
Your Windows® system administrator may set up protected directories on your 
computer or computer network for the secure storage of Protocol and Results files. 
These protected directories must be set up using Windows® tools, and are keyed to 
your Windows® user name and password (which may be different than your Bio-
Plex Manager user name and password). Consult your system administrator for 
information about protected directories. 

Locking Bio-Plex Manager Security 
Edition 

If you are stepping away from the computer and want to prevent anyone else from 
using Bio-Plex Manager Security Edition, you can lock the application. Once locked, 
the application can only be unlocked by the user who locked it or a Supervisor-level 
user. 

¾ Locking Bio-Plex Manager will not shut down the application or end any instrument 
operations that are in progress. 

To lock the application, go to the Tools menu and select Lock Application. You will 
be notified that the application is locked, and the Log In dialog will be displayed. 

To unlock the application, enter your name and password and click on OK. 

¾ If a Supervisor-level user unlocks the application, that Supervisor-level user will 
then be logged in as the current user. 

Logging Off 
When you close Bio-Plex Manager Security Edition, you will be automatically 
logged off. You can also log off without closing the application. 
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Note that you cannot log off while the Bio-Plex array reader is in operation. Logging 
off will close all open documents. You will be prompted to save any changes before 
logging off. 

To log off, go to the Tools menu and select Log Off Application. You will be notified 
that you have successfully logged off and the Log In dialog will be displayed. 
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Appendix 1.  
Troubleshooting Guide 
Message/Problem Cause Solution 

Most Likely:  "Bio-Plex Manager 
has detected a 
problem with low 
bead number" 

Too few beads in the assay 
(5,000 per region recommended). 

Check bead number calculations in 
assay. 

 Plate not shaken for 30 seconds 
before analysis. 

Remove plate from array reader and 
shake for 30 seconds. 

 Buffer volume in wells is too low 
(must be at least 125µl). 

Re-suspend wells in 125µl. Perform 
REMOVE BUBBLES. 

 Microbubble in cuvette. Perform REMOVE BUBBLES. 
Perform UNCLOG to verify fluidics 
integrity. 

 Low/no sheath fluid. Refill sheath fluid, check sheath 
connections. Perform START UP. 

 Possible clog. Perform UNCLOG and rerun. If 
unsuccessful, repeat. If still 
unsuccessful, contact technical 
support. 

 Less Likely:  

 Incorrect needle height. Adjust needle height. 

 Incompatible plate type used. Replace with flat bottom or filter plate 
and adjust needle height. 

 Vacuum system not calibrated. Calibrate vacuum system (see 
hardware manual). 

 Red laser failure. Contact technical support. 

 Filter plate not flat. Check filter plate flatness (see 
hardware manual). 

 Incompatible suspension buffer 
used. 

Check buffer compatibility (see 
hardware manual). 
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Message/Problem Cause Solution 

Incorrect bead regions were 
selected in the Protocol. 

Compare bead regions in the assay 
with those selected in the Protocol. 

"Bio-Plex Manager 
has detected a 
problem with 
selection of 
regions" 

Incorrect regions were selected 
when preparing the assay. 

Verify regions chosen during assay 
preparation. 

 Too few beads in the assay in 
one or more regions. 

Verify that the correct number of 
beads was used by referring to the 
specific assay preparation procedure. 

Most likely:  

Calibration was performed before 
the array reader was warmed up. 

Perform 30-minute WARM UP and 
recalibrate. 

" Bio-Plex Manager 
has detected a 
possible problem 
due to microbubbles 
in the cuvette or 
photobleached 
beads " 

Calibrated with incorrect CL1 or 
CL2 target values. 

Check that the target values of the 
CAL beads match values entered in 
the software. If different, recalibrate. 

 Array reader was calibrated with 
a dirty MCV Plate III. 

Clean MCV Plate III and recalibrate. 

 Misalignment of optics. Perform OPTICS VALIDATION. 
Contact technical support if values 
are not within range. 

 Less likely:  

 Microbubbles present in cuvette. Perform REMOVE BUBBLES. 

 Calibration beads are 
photobleached (do not expose to 
light for more than 1 hour). 

Recalibrate with new CAL1 beads. 
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Message/Problem Cause Solution 
"Bio-Plex Manager 
has detected a 
problem with bead 
aggregation" 

Incorrect DD gate values used. View histogram in Run Protocol 
window and make sure DD peak falls 
within the gate range. If necessary, 
adjust gates (see page 102). 

 Incorrect DD target value used for 
calibration. 

View histogram in Run Protocol 
window and make sure that the DD 
peak falls within the gate range. 
If running a Luminex-type assay from 
another manufacturer, use only 
Bio-Plex DD settings (targets and 
gates). 

 Clumped beads present.  Vortex plate at 900 rpm for 1 minute.  

 Sheath reservoir is empty. Refill sheath reservoir, then perform 
START UP. 

 Waste reservoir is overfilled. Empty waste and reconnect. 

 Incompatible suspension buffer 
used. 

Check hardware manual for buffer 
compatibility. 

"Check Link" in 
status bar of 
software  

Array reader or microplate 
platform is not turned on. 

Turn on array reader and microplate 
platform. 

 Software is not communicating 
with array reader. 

Close and restart Bio-Plex Manager. 

 Cables between computer and 
array reader or microplate 
platform are loose/not connected. 

Check cables for proper connections. 

"Pressurizing" in 
status bar of 
software 

Leak in sheath bottle or cap. Tighten sheath cap. 

Needle stuck in 
down position 

Protective assay plate covering 
was not removed. 

See hardware manual for procedure 
for raising needle stuck in down 
position. Then remove cover from 
assay plate. 

 Needle guide is not screwed all 
the way in. 

Tighten needle guide by turning tube 
clockwise until tight. 

 Sample needle is bent. Replace bent needle with a new 
needle (see hardware manual for 
procedure). 
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Message/Problem Cause Solution 
No Assay Signal 
Detected 

Most likely:  

 Error in assay preparation. Make sure that streptavidin and 
cytokine standards have been added. 
Consult assay preparation procedure. 

 Incorrect target values used in 
calibration. 

Check that target values in the 
Calibrate dialog match the values on 
CAL1 and CAL2 bottles. 

 Waste container overfilled. Empty waste. Reconnect waste. 
Perform UNCLOG. 

 Sheath reservoir low or empty. Refill sheath reservoir. Perform 
START UP. Proceed with run. 

 Less likely:  

 Waste line not connected 
properly. 

Check waste line connection. Make 
sure that it clicks into place. 

 Laser not functioning. Perform calibration. If no signal 
detected, call technical support. 

Most likely:  "Bio-Plex Manager 
has detected a 
change in sheath 
pressure"  

Sheath reservoir cap not on 
securely. 

Tighten sheath cap. Message should 
disappear within two minutes. 

 Sheath bottle lines are not 
connected properly. 

Make sure that all hoses are 
connected to the appropriate ports, 
and that they have clicked into place. 

 Less likely:  

 Sheath fluid level above the AIR 
port on the sheath container. 

Adjust sheath fluid level so that 
sheath fluid is below the AIR port of 
sheath bottle. 

 Sheath bottle has a leak. Try new sheath bottle. Call technical 
support for further assistance. 

 High-throughput fluidics (HTF) 
system not turned on. 

Turn on HTF and check to ensure that 
message disappears. 

 Air Compressor not working. Listen for air pump to turn on when 
WARM UP is selected. Contact 
technical support for further 
assistance. 
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Message/Problem Cause Solution 
Bio-Plex Manager 
has detected a 
change in the 
temperature of the 
array reader. Please 
calibrate before 
running an assay to 
ensure accurate 
results. 

Room temperature has changed. Calibrate array reader. 

The calibration was 
unsuccessful. 
Please repeat 
calibration. If 
calibration fails a 
second time, 
consult 
Troubleshooting 
Guide.  

Calibration procedure failed.  Make sure CAL1 beads and CAL2 
beads are placed in the appropriate 
wells (CAL1 in red well and CAL2 in 
green well). Repeat calibration. 
 
If problem persists, contact technical 
support. 

The calibration was 
unsuccessful. 
Bio-Plex Manager 
has detected a 
problem with low 
bead number. 
Please repeat 
calibration.  

Calibration procedure failed due 
to low bead number. 

Run UNCLOG procedure, then repeat 
calibration. If problem persists, 
contact technical support. 

Optics Validation 
Procedure shows 
value(s) outside of 
acceptable range(s). 

Problem with optical component 
of array reader. 

Repeat validation procedure. If values 
are still out of range, contact technical 
support. 

Fluidics Validation 
Procedure shows 
value(s) outside of 
acceptable range(s). 

Problem with fluidics component 
of array reader. 

Repeat validation procedure. If values 
are still out of range, contact technical 
support. 

Reporter Validation 
Procedure shows 
value(s) outside of 
acceptable range(s). 

Problem with optical component 
of array reader. 

Repeat validation procedure. If values 
are still out of range, contact technical 
support. 

Classify Validation 
Procedure shows 
value(s) outside of 
acceptable range(s) 

Problem with calibration or optical 
component of array reader. 

Repeat validation procedure. If values 
are still out of range, contact technical 
support. 
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Message/Problem Cause Solution 
Beads not resuspended. Resuspend beads and repeat 

validation procedure. If procedure still 
fails, contact technical support. 

Optics, Fluidics, 
Reporter, or Classify 
Validation 
Procedure fails due 
to low bead number Clog in instrument. Perform UNCLOG operation and 

repeat validation procedure. If 
procedure still fails, contact technical 
support. 

Platform heater not 
at target 
temperature 

Insufficient warm-up time 
allowed. 

Allow at least 15 minutes for platform 
heater to reach target temperature. If 
heater does not reach target in 30 
minutes, contact technical support. 

 Platform heater not functioning 
properly. 

Contact technical support. 

Platform heater not 
at ambient 
temperature 

Insufficient cool-down time 
allowed. 

Open platform door to facilitate 
cooling. An ice pack can also be 
placed on the platform plate holder to 
facilitate cooling. 
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Appendix 2.   
Glossary 
Accuracy The closeness of a measured value to the actual value or the 

difference between expected and measured values. Using the 
Reporter Validation Kit, accuracy is defined as the percent 
difference between the measured regression curve and the 
expected or actual data points. 

Aggregated 
microspheres 

Microspheres that have associated. Two microspheres that 
have associated are called a doublet. 

Analyte The substance being measured, identified, quantitated or 
otherwise analyzed in an experiment. In the Bio-Plex 
system, analytes are molecules that are being quantitated. 

Antibody Immunological protein capable of binding a unique antigen 
via a specific binding site or epitope. Used in immunological 
assays to quantitate the amount of a specific analyte present. 

Assay The bead and reagent mixture that, when combined with 
sample, is loaded into microplate wells and is read by the 
Bio-Plex array reader. 

Background (noise) Fluorescent intensity measured by the reporter channel that 
is due to non-specific binding of a fluorochrome and the 
electronic noise of the array reader. If you include blank 
wells in your microplates, you can calculate the average 
background intensity and subtract it from the intensity 
readings of your standards and unknowns. 

Bead A microsphere. 

Calibration A process that uses microspheres (calibrators) with a stable 
fluorescent intensity to adjust the gain settings in the 
Bio-Plex array reader’s detectors for optimal and consistent 
microsphere classifications and reporter readings, over time 
and across different array readers. 

Calibrators Microspheres with stable fluorescent intensities used to 
standardize the signal output of the Bio-Plex array reader. 

 173 



Bio-Plex Manager User Guide  

Capture antibody An antibody used in sandwich immunoassays that binds or 
"captures" a specific analyte for quantitation. 

Carboxylated 
microspheres 

Microspheres with chemically modified surfaces such that 
they are covered with carboxyl functional groups (COOH) 
that allow covalent biomolecular attachment. 

Classification channels Fluorescent detection channels of the Bio-Plex array reader 
that detect the fluorescent intensities of two dyes embedded 
in the Bio-Plex microspheres. The ratio of the two dyes 
identifies each bead as a unique analyte within a sample.  

Classify validation A validation procedure for measuring the ability of the 
Bio-Plex array reader to efficiently classify assay beads into 
specified regions. 

Clumping The aggregation of two or more microspheres. 

Conjugated 
microspheres 

A microsphere set that has been chemically modified so that 
its surfaces are covered with molecules that bind with the 
target analytes in an assay system. 

Coupled microsphere See conjugated microsphere. 

Cytokine  An immunological protein that can signal a response in the 
immune system. 

Detection antibody An antibody used in capture sandwich immunoassays that 
binds a captured analyte to a fluorochrome, allowing for 
quantitation of the protein. Detection antibodies may be 
biotinylated, which allows for addition of a streptavidin-
bound fluorochrome, or the detection antibody may be 
directly labeled with a fluorochrome. 

Doublet Two microspheres that have associated. The resulting signal 
of the associated microspheres is twice that of a single 
(singlet) microsphere. 

Doublet discriminator A channel that measures the amount of light scatter from 
particles that flow past the red laser. Light scatter is directly 
proportional to particle size, and the channel is designed to 
identify particles that are smaller or larger than a single 
microsphere, including microspheres that are clumped or 
aggregated. 
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Dynamic range The calculated number of decades covered by the reporter 
channel scale of the Bio-Plex array reader. Range is 
calculated using the Reporter Validation Kit. 

Emission spectrum The wavelength range of light emitted by an excited 
fluorochrome when its electrons fall from a higher to a lower 
energy state. Expressed in nanometers (nm). 

Ex/Em A common way of reporting a molecule’s excitation and 
emission wavelengths (for example, Ex/Em = 488/520 nm). 

Excitation spectrum The wavelength range that excites a molecule’s electrons to 
a higher energy state. Expressed in nanometers (nm). 

External standard A standard that has been imported from a different file. 

Fit probability A statistical measure of goodness of fit that incorporates the 
residual SSE. A fit probability of 1 indicates a perfect fit, 
while a fit probability of 0 indicates no fit. 

Fluidics validation The process of verifying the well-to-well carryover of beads 
in the Bio-Plex array reader. 

Fluorescence The emission of light that occurs when the electrons of a 
fluorochrome drop to a lower energy state. 

Fluorochrome A fluorescent molecule. 

Gate An electronic method of discriminating or eliminating 
aggregated microspheres in the analysis of an assay. A gate 
separates singlet beads from aggregated beads. 

Group A group of wells defined on a plate. You can calculate the 
ratio of the fluorescent intensities of the group's member 
wells to the fluorescent intensity of a Reference well in the 
group. 

Immunofluorescence A technique that uses a covalently linked fluorochrome-
antibody complex to detect or quantify a particular antigen. 

Kinase   An enzyme that functions to phosphorylate specific proteins. 
Kinases are responsible for the activation of a variety of 
proteins through the process of phosphorylation. 
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Laser A highly purified source of light used to excite fluorochrome 
electrons. An acronym for Light Amplification by 
Stimulated Emission of Radiation. 

Linearity A measurement of the coefficient of determination or R2 
value of a set of standard beads. An R2 value of 0.995 or 
greater is an acceptable linearity value using the Bio-Plex 
validation kit. 

Logistic regression A regression model for binary (dichotomous) outcomes. The 
data are assumed to follow binomial distributions with 
probabilities that depend on the independent variables. 

Median fluorescent 
intensity 

A relative measurement of fluorescent intensity based on the 
median, a robust statistical measure. 

Microparticle A solid substance with a diameter in the micrometer range. 
Often used as a synonym for a microsphere. 

Microsphere set A set of Bio-Rad multianalyte microspheres containing a 
unique mixture of two distinct fluorochromes to distinguish 
them from other multianalyte microspheres. 

Microspheres Latex spheres with a diameter in the micrometer range. Also 
called beads. 

Multianalyte or 
multiplex 

An analysis of several assays or tests performed 
simultaneously in the same reaction container. 

Operational 
qualification 

The process of determining that an instrument is fit for its 
intended use. The Bio-Plex Validation Kit is a tool for 
operational qualification. 

Optics validation The process for verifying the alignment of the optics 
assembly of the Bio-Plex array reader. 

Outlier A well or replicate group of wells whose measured value is 
outside the normal range. You can exclude outliers from 
statistical calculations. 

Panel A group of related bead sets. For example, the Human 
Cytokine panel includes bead sets for Human IL-2, Human 
IL-4, Human IFN gamma, and other human cytokines. You 
can select multiple bead sets from the same panel or sets 
from different panels in the same multiplex assay. 
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PE See phycoerythrin. 

Phosphoprotein An enzyme that functions to phosphorylate specific proteins. 
Phosphoproteins are responsible for the activation of a 
variety of proteins through the process of phosphorylation. 

Photobleaching A chemical reaction caused by exposure to light, in which a 
fluorochrome is converted into a differently fluorescent or 
non-fluorescent compound. 

Photomultiplier tube A light detector typically used in fluorescence detection 
systems, designed to convert a fluorescent signal into an 
electronic signal that can be quantitated. 

Phycoerythrin (PE) The fluorochrome used as the reporter molecule in Bio-Plex 
assays. Excitation = 546 nm, emission = 575 nm. 

PMT See photomultiplier tube 

Precision A measure of the reproducibility of replicate readings, 
usually represented by the coefficient of variation (CV%). 

Protocol file (*.pbx or 
*.spbx) 

A file containing the settings of a reading, including the 
microplate wells to read, the analytes to detect, sample size, 
etc. To perform a reading, you open a Protocol file, select 
the settings, and then run the Protocol. You can then save the 
Protocol settings and reuse or modify them. After a reading, 
a Results file is created containing the settings from the 
Protocol as well as the data results. The raw data from the 
most recent reading is also stored in the Protocol file. In Bio-
Plex Manager Security Edition, Protocol files may be Secure 
files, in which case they have the file extension *.spbx. 

Quality control Procedures and guidelines that determine conformity to 
requirements. 

Recovery percentage A mechanism for assessing the fit of the standard curve to 
the actual standards. For each analyte standard, an observed 
concentration is back-calculated from the standard curve and 
the fluorescent intensity. This is divided by the expected 
concentration and multiplied by 100 to give the recovery 
percentage. 
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Recovery Range The range of acceptable recovery percentages (see above). 
For example, a recovery range of 80–120% means that the 
observed concentration of a standard should be within 80–
120% of the expected concentration. Concentrations of 
standards and unknowns that fall outside this range are 
flagged as unreliable. 

Reference A well within a group of wells defined on a plate that is used 
as a reference. You can calculate the ratio of the fluorescent 
intensity of the Reference well to the fluorescent intensities 
of the other wells in the group. 

Region The region of a fluorescent color map used to identify a 
particular bead set. Each bead set is embedded with specific 
quantities of two fluorescent dyes; the combination of these 
fluorochromes, as detected by the Bio-Plex array reader, 
places the bead set within a unique region on the color map, 
thereby identifying the set and its associated analyte. 

Reporter A fluorescent molecule that is incorporated into an assay in 
such a way that the fluorescence intensity is directly 
proportional to the amount of analyte in an assay.  

Reporter channel The channel of the Bio-Plex array reader that detects the 
fluorescent signal of the reporter molecule (phycoerythrin).  

Reporter system Any combination of molecules in solution that serves to 
quantitate the analytes in a particular assay. 

Reporter validation A standard method for verifying the performance of the 
reporter channel of the Bio-Plex array reader. The five 
primary parameters that verify accurate performance of the 
reporter channel include linearity, dynamic range, 
sensitivity, accuracy and slope of the response. 

Residual variance A statistical measure of goodness of fit. This is the weighted 
sum of the squared errors between the observed response 
and the response predicted by the fitted curve (residual 
SSE), divided by the number of degrees of freedom. A small 
residual variance indicates a good curve fit. 
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Results file (*.rbx or 
*.srbx) 

A file containing the results of a reading, including the raw 
data, the settings information from the Protocol, and tools 
for analyzing and exporting the data (tables, a standard 
curve, export functions, etc.). Each reading generates a new 
Results file. In Bio-Plex Manager Security Edition, Results 
files may be Secure files, in which case they have the file 
extension *.srbx. 

Sample A solution of analyte standards or unknowns that, when 
added to an assay, will bind to the microspheres in that assay 
and be identified and quantitated by the array reader. 

Sampling error A measure of the degree to which a sample differs from the 
entire population. 

Sandwich immunoassay Immunoassay for the quantitation of a specific analyte 
through the use of monoclonal antibodies (Ab). A sandwich 
is formed when an analyte of interest binds to a capture Ab, 
and then a second antibody (detection Ab) binds to a 
different epitope of the protein. 

Secure file A Protocol or Results file that has been electronically 
“signed” by a user. Once signed, this file is a controlled 
document that cannot by overwritten by Bio-Plex Manager 
and that preserves a built-in audit trail of all saved changes. 
If you make changes to a Secure file and save it as a new 
file, the new file will not be signed; however, the audit trail 
will be preserved in the new file and the file will remain a 
Secure file. 

Sensitivity The lowest detectable signal above instrument noise. Noise 
may be attributed to the lasers, the detectors and the 
amplification electronics of the array reader. 

Signal The detectable measurement unit of a reporter molecule. 

Signal-to-noise ratio The ratio of a specific assay signal to the underlying noise in 
the assay. Signal to noise is typically used to measure the 
sensitivity of an assay. 

Singlet(s) A single microsphere or a population of single microspheres. 
Compare to doublets which are two microspheres associated 
together. 
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Slope Defined as the rise over the run when plotting a series of 
points to form a line. Using the Reporter Validation Kit, the 
slope of the response is related to the dynamic range of the 
array reader and yields information about the response of the 
photomultiplier tube (PMT). 

Spectral address The unique fluorescent emission spectra of a microsphere. 

Standard deviation The spread in individual data points (e.g., in a replicate 
group) to reflect the uncertainty of a single measurement. 

Standard error The standard deviation of a set of replicates divided by the 
square root of the number of replicates. 

Unconjugated 
microspheres 

A microsphere set that has been chemically modified so that 
its surfaces are covered with some functional group, but that 
has not been chemically prepared for use as a component in 
an assay system. These base microspheres do not carry 
biomolecular reactant. 

Uniformity The reproducibility of a signal over a series of replicate 
measurements. 

Validation A formal process for documenting that an instrument is fit 
for its intended use and is kept in an appropriate state of 
maintenance and calibration. 

Validation kit A set of reagents and procedures designed to verify the 
performance of the Bio-Plex array reader apart from an 
assay. Validation Kit 4.0 assesses the alignment of the optics 
assembly, measures the performance of the reporter channel, 
evaluates the fluidics system, and verifies the classify 
efficiency of the Bio-Plex array reader. 

Variance The mean square deviation of a variable around the average 
value. 
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Table Error Codes 
Certain data that cannot be measured or calculated will be flagged in the Raw Data and 
Report tables. Columns and their possible error codes are listed below: 

Column Error Code Cause 
FI *** No data present 
 --- Marked as an outlier 
FI – Bkgd *** No data present (negative values, if any, will be 

displayed) 
 --- Marked as an outlier 
SD *** No data present 
CV% *** No data present 
Obs Conc 
(4PL/5PL) 

*** No data present 

OOR> Out of Range - Above asymptote of equation 
OOR< Out of Range - Below asymptote of equation 
OOR Out of Range - Math Error 

*Value Above or below standards FI 
Obs Conc 
(Linear)) 

*** No data present 

OOR Negative extrapolated data 
*Value Positive extrapolated data or 

Data above/below the standards FI 
Exp Conc *** No data entry - this value is input by user 
Obs/Exp*100 *** OOR displayed in Obs Conc column 
Conc In Range *** Obs Conc is not within the specified recovery 

range of standards conc (the recovery range is 
specified by the user; see page 83) 

Sampling Error 1 Low bead number detected in the well 
 2 Aggregated beads detected in the well 
 3 Classify efficiency problem detected in the well 
 4 Region selection problem detected in the well 
 5 Platform temperature problem detected in the 

well 
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Appendix 4. Security 
Edition: User Access by 
Function 

The following table lists the functions and user levels in Bio-Plex Manager Security 
Edition. An X indicates that the user level has access to the function. 

 

Function Admin Supervisor Service Clinician 2 Clinician 1 Reviewer 

Functions that Apply to Whole Application 

Opening Files  X X X X X 

Viewing All Screens (Not 
Modify)  X X X X X 

View Audit Trail  X X X X X 

Printing  X X X X X 

Save  X X X X  

Save As  X X X X  

Exporting  X X X X X 

Electronically Sign Document  X X X X X 

Functions that Apply to Instrument Control 

Start Up  X X X X   

Shut Down  X X X X   

Warm Up  X X X X   

Remove Bubbles  X X X X   

Wash Between Plates  X X X X   

Run Calibration  X X X X   

Enter Calibration Lot/Exp 
Date  X X X X   

Run Validation  X X X X   

Enter Validation Lot/Exp Date  X X X X   

Instrument - Set Up  X X X X   
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Function Admin Supervisor Service Clinician 2 Clinician 1 Reviewer 

Instrument – Reconnect  X X X X   

Instrument Info  X X X X  

View Operation Log X X X X X X 

View Calibration Log X X X X X X 

View Validation Log X X X X X X 

Functions that Apply to Protocol File — General 

New Protocol File  X X       

New Results from Protocol  X X  X X   

Functions that Apply to Protocol File, Describe Protocol View 

Author Field  X X    

Description Field  X X    

Functions that Apply to Protocol File, Select Analytes View 

Select /Remove Analytes  X X       

Add/Delete/Rename/Edit 
Panel  X X       

Functions that Apply to Protocol File, Format Plate View 

Formatting Wells   X X    

Change Number of Unknown 
Samples   X X X   

Functions that Apply to Protocol File, Enter Standards Info View 

Enter Standards Info 
(Description & Concentration)  X X       

Enter Std Curve Regression 
Method  X X       

Enter Std Curve Adv Settings  X X       

Enter Std Concentration Units  X X       

Enter Recovery Range  X X       

Select External Standards  X X       

Functions that Apply to Protocol File, Enter Sample Info View 

Enter Sample Info (Sample 
Description)  X X X     

Enter Sample Info (Sample 
Dilution)  X X X     

Functions that Apply to Protocol File, Enter Controls Info View 

Enter Controls Info   X X       
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Function Admin Supervisor Service Clinician 2 Clinician 1 Reviewer 

Functions that Apply to Protocol File, Run Protocol View 

Start a Run   X X X X   

Rerun/Recovery Mode  X X X X   

Select Beads to Count  X X       

Select Bead Count Method 
(Per Well/Per Analyte)  X X       

Advanced Settings  X X       

Change Raw Data Display 
Options  X X X X X 

Print Histogram & Bead Map  X X X X X 

Histogram - Restore Default 
Gates  X X       

Histogram – Adjust DD Gates  X X       

Histogram – Autoscale  X X X X X 

Histogram - Log/Linear View  X X X X X 

Histogram – Zoom  X X X X X 

Histogram - Max/Restore  X X X X X 

Bead Map - Log/Lin  X X X X X 

Bead Map – Zoom  X X X X X 

Bead Map - Max/Restore  X X X X X 

Functions that Apply to Results File — General 

New Protocol from Results  X X       

Change DD Gates  X X       

Refresh Calculations  X X X X X 

Modify Plate ID  X X    

Functions that Apply to Results File, Describe Protocol View 

Author Field  X X    

Description Field  X X    

Functions that Apply to Results File, Select Analytes View 

Select /Remove Analytes  X X       

Add/Delete/Rename/Edit 
Panel  X X       

Functions that Apply to Results File, Format Plate View 

Formatting Wells   X X    
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Function Admin Supervisor Service Clinician 2 Clinician 1 Reviewer 

Functions that Apply to Results File, Enter Standards Info View 

Enter Standards Info 
(Description & Concentration)  X X       

Enter Std Curve Regression 
Method  X X       

Enter Std Curve Adv Settings  X X       

Enter Std Concentration Units  X X       

Enter Recovery Range  X X       

Select External Standards  X X       

Functions that Apply to Results File, Enter Sample Info View 

Enter Sample Info (Sample 
Description)  X X      

Enter Sample Info (Sample 
Dilution)  X X      

Functions that Apply to Results File, Enter Controls Info View 

Enter Controls Info (Desc, 
Conc, & Dilution)  X X       

Functions that Apply to Results File, Raw Data View 

Change Raw Data Display 
Options   X X X X X 

Set/Clear Outliers  X X    

Functions that Apply to Results File, Report Data View 

Set/Clear Outliers  X X    

Show/Hide Outliers  X X X X  X 

Report Table Options  X X X X X 

Organize by Type   X X X X X 

Organize by Group  X X X X X 

Show Replicates  X X X X X 

Sort  X X X X X 

Show Help for Table Legend  X X X X X 

Select Analytes to View  X X X X X 

Functions that Apply to Results File, Standard Curve View 

Regression Type  X X       

Same Regression Type for 
All Analytes  X X       

Logistic Weighting Options  X X       
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Function Admin Supervisor Service Clinician 2 Clinician 1 Reviewer 

Labels  X X X X X 

Error Bars  X X X X X 

Analyte  X X X X X 

Axis Transformation  X X X X X 

Swap XY Axes  X X X X X 

Turning On and Off Secure Mode 

Turn On/Off Secure Mode X          

Unlock Application Override  X         

Note: System Administrator Creates Groups And Assign Users To Groups 
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Appendix 5.  
Basic Concepts 

The following is a brief overview of the basic principles of the Bio-Plex array 
system. For more information, see Practical Flow Cytometry, 3rd edition, by 
Howard M. Shapiro, M.D. (New York: Wiley-Liss Inc., 1995). 

Microspheres 

Bio-Plex microspheres are highly uniform, 5.5-micron polystyrene beads that have 
been crosslinked during polymerization for physical and thermal stability. 
Microspheres are grouped into sets; each set is then embedded with specific 
quantities of two fluorescent dyes. The ratio of these two dyes gives each set of 
microspheres a unique spectral address. 

Each set of microspheres is then conjugated with a different reactant specific for a 
particular target analyte. Reactants can include enzyme substrates, receptors, 
antigens, and antibodies. A conjugated bead-reactant mixture can be mixed with a 
sample to create, for example, a capture sandwich immunoassay. 

¾ To ensure the stability of the spectral address, it is essential to protect the 
microspheres from light. Do not subject microspheres to prolonged high 
temperatures, and protect them from freeze/thaw manipulations. 

Reporter fluorochromes 

When you mix your samples with the microspheres, the target analytes bind to the 
reactants on the surface of the beads. The amount of analyte that binds to the beads is 
then quantitated through the use of a fluorochrome, R-phycoerythrin. The intensity 
of this fluorochrome as detected by the Bio-Plex array reader is directly proportional 
to the amount of analyte present. The excitation wavelength of the Bio-Plex array 
reader reporter channel is 532 nm, while the emission wavelength is 575 + 12nm. 
Specific information on R-phycoerythrin is shown in the following table: 
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 R-Phycoerythrin 

Formula weight (Daltons) 240,000 

Absorbance max (nm) 480, 546, 565 

Extinction max (M-1cm-1) 1,960,000 

Emission max (nm) 578 

Quantum yield 0.82 
 

Fluidics 

There are two fluidic paths in the Bio-Plex array reader. The first path includes a 
syringe-driven mechanism that controls the sample uptake. This mechanism permits 
small sample uptake volumes from small reaction volumes. The syringe-driven 
system transports a user-specified volume of sample from a microplate well to the 
cuvette. The sample is injected into the cuvette at a steady rate, and the microspheres 
in the sample are aligned in a single file through the path of the two Bio-Plex lasers. 

Following analysis, the first sample path is automatically purged with sheath buffer 
fluid via the second fluidics path. This process effectively removes residual sample 
in the tubing, valves, and sample needle. 

Excitation 

There are two lasers in the Bio-Plex array reader: one for classifying each 
microsphere and its associated analyte, and the other for quantitating the amount of 
analyte bound to each microsphere. The first laser, called the classification or "red" 
laser, excites the dyes embedded in each microsphere; the fluorescent signal is 
discriminated with selective emission filters and converted into intensity units by 
fluorescence detectors and a digital signal processor, and the microsphere is 
classified. The second laser, called the reporter or "green" laser, excites the 
fluorochromes bound to the target analytes on the surface of the microspheres; again, 
the fluorescent signal is discriminated with selective emission filters and converted 
into intensity units by fluorescence detectors and a digital signal processor, and the 
amount of analyte is quantitated. 
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Appendix 6.  
Microsphere Handling 

Microsphere Dispersion 

Bio-Plex microspheres will settle and aggregate if left undisturbed. You should 
always ensure that they are evenly distributed before dispensing. Gentle vortexing is 
the most effective method of mixing for most coated microsphere preparations; 
however, sonication can also be used to separate aggregated microspheres prior to 
coupling. After sonication, microspheres generally remain dispersed for about 
1 hour. Sonication is most effective if applied to a centrifuged pellet of microspheres. 
In order to maintain bead concentration, we suggest that you centrifuge your stock 
beads before sonication. 

The following two indirect sonication methods are effective at separating aggregates 
in closed containers of microsphere preparations. 

Inserting a sonicator probe into preparations is not recommended 

Probe Sonicator 

To disperse a microsphere pellet using a probe sonicator: 

1. Place probe tip in a small bath of water. 

2. Insert the end of the microsphere tube near the tip of the sonicator probe, 
without touching it. Do not immerse the tube closure. 

3. Adjust sonication for optimal disruption and pulse sonicate until the 
microsphere pellet is dispersed. 

Bath Sonicator 

To disperse a microsphere pellet using a bath sonicator: 

1. Turn on the bath sonicator and examine the surface for an area of maximum 
disruption. 
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2. Insert the end of the tube into the sonicator bath near the area of maximum 
disruption. 

3. Sonicate until the microsphere pellet is dispersed. 

Enumeration of Microsphere Suspensions 

Bio-Plex microspheres are provided at standard concentrations. The microsphere 
yield after a coupling process may be less than the starting concentration due to loss 
during wash steps. The microsphere loss can vary according to operator technique, 
coupled reactant properties, and scale of coupling. 

It is not advisable to construct an assay without defining the concentration of the 
subject-coupled microsphere preparation. The total surface area (total number of 
microspheres) represented in an assay is a critical variable, so the optimization and 
control of this variable begins with manipulation of known microsphere numbers. 
Microspheres can be counted with a hemocytometer. Please follow counting and 
calculation methods outlined in the instructions for your hemocytometer. 

Microsphere separation methods 

Bio-Plex assay development often requires separation of microspheres from an 
aqueous matrix. 

Centrifugation 

Microsphere coupling protocols require separation of microspheres from reaction 
mixtures or wash buffers by means of centrifugation. Generally, a tabletop 
microcentrifuge that can spin 1.5 ml microcentrifuge tubes can pellet Bio-Plex 
microspheres in 1–2 minutes. The g-forces vary in these instruments from 
approximately 6,000 to 13,000 × g. 

Vacuum 

A vacuum separation method can be used for routine high throughput washing 
required for washed assay procedures. In this case, the microsphere reactions are 
performed in microtiter filter-bottom 96-well plates. A vacuum is applied to the plate 
allowing the liquid to filter through while retaining the microspheres on the filter. 
Resuspension is accomplished by adding adequate fluid to each well and by 
repetitive vigorous pipetting. 
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Microsphere Agitation During Assay 

Agitation of Bio-Plex assays with a plate shaker during incubation steps prevents 
microspheres from settling during extended incubation periods. The benefit of 
agitation may not be discernible for some assay conditions and should be evaluated 
according to the requirements of a given application. It is important to resuspend the 
beads in an assay for 30 seconds to performing a Bio-Plex reading. 

Microsphere Stability and Storage 

Bio-Plex microspheres are light sensitive and should be protected from light during 
all stages of storage and usage. In addition, freezing conditions and organic solvents 
should be avoided. 

193 



Bio-Plex Manager User Guide  

 

194 



 

Appendix 7.  
Bio-Plex Product Numbers 
Product Product Number
Bio-Plex Systems  

Bio-Plex Protein Array System, including array reader, microplate 
platform, computer, monitor, Calibration Kit, Validation Kit 4.0, MCV 
Plate III, sheath fluid (20 L), Bio-Plex Manager Software with 
Workstation license, and a spare sample needle 

171000001 

Bio-Plex Protein Array System, same as 171000001, except with Bio-
Plex Manager Security Edition with Workstation License 

171000002 

Bio-Plex Protein Array System, same as 171000001, except with High-
Throughput Fluidics (HTF) 

171000005 

Bio-Plex Protein Array System, same as 171000005, except with 
Bio-Plex Manager Security Edition with Workstation License 

171000006 

Software Upgrade  

Bio-Plex Manager 3.0 to 4.0 Workstation Software Upgrade Kit, 
including Bio-Plex Manager 4.0 CD-ROM, Workstation license, 
Validation Kit 4.0, and MCV Plate III 

171001008 

Software Packages  

Bio-Plex Manager 4.0 Security Edition—Workstation license 171001012 

Bio-Plex Manager 4.0— Workstation license 171001013 

Bio-Plex Manager 4.0—Desktop license 171001014 

Bio-Plex Manager 4.0—5-User Network Desktop license 171001015 

Bio-Plex Manager 4.0—10-User Network Desktop license 171001016 

Bio-Plex Manager 4.0—20-User Network Desktop license 171001017 

Bio-Plex Manager 4.0 Security Edition—Desktop license 171001018 

Bio-Plex Manager 4.0 Security Edition —5-User Network Desktop 
license 

171001019 

Bio-Plex Manager 4.0 Security Edition —10-User Network Desktop 
license 

171001020 

Bio-Plex Manager 4.0 Security Edition —20-User Network Desktop 
license 

171001021 
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Product Product Number
Validation and Calibration Accessories  

MCV Plate III 171203032 

Validation Kit 4.0 171203001 

Calibration Kit 171203060 

Bio-Plex System Accessories  

Sheath Fluid, 20 L 171000055 

Communications Cable, 5 ft., DB9 171002001 

Bio-Plex System Hardware Instruction Manual 4006025 

Bio-Plex Manager 4.0 User Guide 10000438 

Bio-Plex Reader Accessories  

Bio-Plex Sheath Fluid Bottle 171002010 

Bio-Plex Sheath Waste Bottle 171002012 

Bio-Plex Sample Needle, Long 171002020 

Bio-Plex Needle Adjustment Wrench 171002026 

Bio-Plex Reader Protective Shield 171002030 

Microplate Platform Accessories  

Bio-Plex Needle Guide 171002023 
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Appendix 8.  
Reporting Problems 

Included in your Bio-Plex Manager installation is a program called Solobug. We 
would like you to use this program to request features, request design changes, or 
report noncritical problems with Bio-Plex. 

¾ For critical problems, contact Bio-Rad technical support at the numbers listed on 
page 13. 

To use Solobug, select Solobug from the Start menu, enter your information and a 
description of the request in the Solobug window, and click on Save. This will create 
a report that you can attach to an e-mail and send to Bio-Rad. 

Please send your Solobug files to Bio-Rad at: 

LSG.TechServ.US@Bio-Rad.com (in the U.S.) 

LSG.TechServ.Intl@Bio-Rad.com (International) 
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Appendix 9.  
Software Warranty 

Bio-Rad Laboratories warrants that Bio-Plex Manager software shall substantially 
conform, in all operational features, to Bio-Rad’s current specifications as published 
in Bio-Rad’s user and installation guides and that, when properly installed, it will be 
free of material defects which affect system performance. 

The Purchaser must notify Bio-Rad in writing, within 30 days of delivery of the 
software (not including delivery of any subsequent modifications to the software), of 
any defect. If the software is found to be defective by Bio-Rad, Bio-Rad’s sole 
obligation under this warranty is to remedy the defect in a manner consistent with 
Bio-Rad’s regular business practices. For a defect which adversely affects the 
performance of the software, Bio-Rad shall use its best efforts to cure such defect as 
soon as reasonably practicable after receipt of Purchaser’s notice. For minor defects, 
Bio-Rad shall use its best efforts to correct such minor defects in the next release of 
its software. If, however, Bio-Rad is unable to cure a major defect within 90 days of 
receipt of Purchaser’s notice, Purchaser shall have the option to cancel this 
agreement, whereupon Bio-Rad shall refund only the software fees paid. 

The warranties set forth in this agreement are in lieu of all other representations and 
warranties, expressed or implied, including warranties of merchantability and fitness 
for a particular purpose and any other statutory or common-law warranty. Bio-Rad 
on its own behalf expressly disclaims and excludes any and all such other 
representations and warranties. Liability of Bio-Rad to Purchaser, if any, for breach 
of warranty, or any other claim relating to this agreement, shall be limited to the total 
amount of software fees paid by purchaser to Bio-Rad. In no event shall Bio-Rad be 
liable for incidental or consequential damages, loss of business or profits, special or 
indirect damages of any nature whatsoever. No amendment, waiver, or other 
alteration of the warranties in this agreement may be made except by mutual 
agreement in writing. 

Purchaser agrees that Bio-Rad’s liability arising out of contract, negligence, strict 
liability in tort or warranty shall not exceed the amount of software license fees paid 
by Purchaser. 
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This manual and the software (computer program) described in it are copyright 
Bio-Rad Laboratories, Inc. with all rights reserved worldwide. Under the copyright 
laws, this manual and the software program contained herein may not be copied, in 
whole or in part, without the prior written consent of Bio-Rad, except in the normal 
use of the software or to make a backup copy. This exception does not allow copies 
to be made for others, whether or not sold, but all of the materials purchased (with all 
backup copies) may be sold, given or loaned to another person. Under the law, 
copying includes translating into another language or format. 

A multiuse license may be purchased to allow the software to be used on more than 
one computer owned by the purchaser, including a shared disk system. 
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